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1  Welcome
The R&S NRPV power meter software application represents power measurement for
the most relevant frequency bands and power classes. By communicating with
R&S power sensors, the program covers a wide range of applications, e.g., the basic
continuous average measurement, timeslot burst and scope measurement.

The NRP and R&S NRP‑Z power sensors are highly accurate standalone measuring
instruments. With their internal CPU, the power sensors process the measurement
results and communicate directly with a PC over USB. Also, the NRP network sensors
are equipped with a Gigabit Ethernet interface with power over Ethernet (PoE) power
supply.

With a high dynamic range and automatic error correction, the power sensors are suit-
able for nearly every measurement task. As an example, among other duties,
R&S NRPxP, or R&S NRP‑Z8x measure pulse parameters and you can directly see
the results in the R&S NRPV software.

For measurements with any number of power sensors, the graphical user interface of
R&S NRPV provides functionality and operation comparable to a multichannel oscillo-
scope.

1.1  Documentation overview

This section provides an overview of the R&S NRPV user documentation. Unless
specified otherwise, you find the documents at:

www.rohde-schwarz.com/software/nrp_s_sn

1.1.1  User manual and help

Introduces the R&S NRPV and describes how to set up and start working with the
product. Includes basic operations and measurement examples. Contains also the
description of all application modes and functions.

The contents of the user manual is available as help in the R&S NRPV. The help offers
quick, context-sensitive access.

The user manual is also available for download or for immediate display on the Inter-
net.

1.1.2  Product brochure

The brochure provides an overview of the software and deals with the specific charac-
teristics.

Documentation overview

https://www.rohde-schwarz.com/software/nrp_s_sn
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1.1.3  Release notes and open source acknowledgment (OSA)

The release notes list new features, improvements and known issues of the current
firmware version, and describe the firmware installation.

The software uses several valuable open source software packages. An open source
acknowledgment document provides verbatim license texts of the used open source
software.

1.2  Key features

R&S NRPV supports all sensor features and settings in the following measurement
modes:

● Trace measurement for representing signal power in the time domain. If you are
working with an R&S NRPxP or an R&S NRP‑Z8x power sensor, for example, the
R&S NRPV also supports pulse analysis.

● Numerical measurement modes as:
– Continuous mode to measure the average power of continuous signals.
– Burst mode to analyze pulsed signals. R&S NRPV automatically recognizes the

start and end of a burst. It is possible to exclude pulse build-up and decay pha-
ses, for example to omit signal overshoots.

– Timeslot mode to display the values in a defined time segment. The start and
stop of a pulse signal can be excluded optionally, for example to fade out slow
edges. It is also possible to exclude time domains during measurements, for
example if power fails in certain ranges.

– Gates mode to exclude time segments during measurement.
– Statistics measurements to evaluate the ratio of the signal density/distribution

versus power.

You can view the measurement results directly, or represent ratios of various traces,
and even record and store measurements over a long-term. R&S NRPV indicates the
measurement results numerically and graphically.

In addition, you can set up several measurements in parallel. While a measurement is
active, the others are in standby state, and you can quickly and easily switch between
them.

1.3  Scope of applications

The R&S NRPV covers apart from other functions the following fields of application:
● Test setups and procedures for power amplifiers.
● Measurement of the frequency and/or level response.
● Fast measurement of the transmission characteristics of filters, amplifiers and fre-

quency converters over a large frequency and dynamic range.

Scope of applications
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● Measurement of radar systems and their components.
● Measurements compliant with major communication base station standards, e.g.

GSM, WCDMA, etc.

Scope of applications
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2  System setup
System setup provides information required to prepare the application for power mea-
surement. The section contains soft- and hardware requirements, describes how to
install the software on a personal computer and how to get started.

2.1  Hardware

For controlling the sensors by a PC, the following hardware prerequisites must be fulfil-
led.
Table 2-1: Hardware requirements

 Minimum requirement

CPU Pentium IV 1 GHz or higher

RAM 1 Gbyte

Hard disk 50 Mbyte free space

Monitor XGA monitor (1024 x 768)

Interfaces USB 1.1 or USB 2.0

2.1.1  Supported power sensors

All NRP and R&S NRP‑Z power sensors are supported. For details on supported
power sensors, see the release notes.

2.1.2  Accessories (optional)

● High-speed hubs for USB 2.0 with own power supply for connecting several power
sensors. For information on recommended USB hubs, refer to Section 2.3.2, "Multi-
ple measurement setup", on page 13

● R&S NRP‑Z3, active USB adapter cable (only for R&S NRP‑Z power sensors)
Supports applications that require external triggering of the power sensor, and pro-
vides a separate power supply.

● R&S NRP‑Z4, passive USB adapter cable (only for R&S NRP‑Z power sensors)
Supports all basic functions of the sensors like transmission of settings, measure-
ment data and provides power supply of the sensor over USB.

● R&S NRP‑Z2, extension cable (only for R&S NRP‑Z power sensors)
Cables of various lengths support test setups with distant sources of up to 10 m.

● R&S NRP‑Z5, 4-port USB hub adapter box
The R&S NRP‑Z5 sensor hub covers a high-speed USB 2.0 hub. This sensor hub
allows you to connect up to four R&S power sensors, and supports various trigger
modes, such as:

Hardware
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– Bidirectional triggering from a host, e.g. a PC or an R&S instrument
– Internal triggering
– External synchronous triggering
– Triggering in trigger sender mode together with the R&S NRPxP and

R&S NRP‑Z8x sensors.
To connect a sensor, you can use the R&S NRP‑Z4 USB adapter cable with the
R&S NRP‑Z2 cable extension.
To connect the R&S NRP‑Z5 sensor hub, you can use the R&S NRP‑Z4 adapter
cable, or a standard USB cable. A separate power supply is not required.

● R&S NRP‑ZKU cable with a USB connector (only for NRP power sensors)
Rohde & Schwarz provides cables of various lengths for connecting the NRP
power sensors over USB.

● R&S NRP‑ZK6 cable with a push-pull type connector (only for NRP power sensors)
Cables of various lengths for connecting the NRP power sensors to supported
instruments from Rohde & Schwarz.

2.2  Software

The Virtual Power Meter software runs on PCs with the Microsoft Windows operating
system.

R&S NRPV is available free of charge. You can download the program file at:

www.rohde-schwarz.com/software/nrp_s_sn

The filename is, for example, NRPV_SetupV4.24.1, with subversion x and build num-
ber y.

2.2.1  R&S NRPV software components

The setup program contains all components required for installation and operation of
the R&S NRPV, for example:
● NRPV.exe, the executable application file.
● Release notes (PDF) with up-to-date notes on the individual components and soft-

ware versions.

2.2.2  Installing the R&S NRPV virtual power meter software

This section describes the installation of the R&S NRPV software on a Microsoft Win-
dows PC. Also, the section contains information on the software packages, prerequi-
sites and uninstalling.

Prerequisites

● R&S NRPV requires at least 50 MB of free disk space.

Software

https://www.rohde-schwarz.com/software/nrp_s_sn
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● Use the latest version of the R&S NRPV software.
● Close all running applications before installing.

1. Download the latest version of the R&S NRPV setup program, see Section 2.2,
"Software", on page 9.

2. Execute the EXE file.

3. Follow the instructions of the setup wizard.

During installation, in the setup program:
● Installs the Microsoft VC runtime libraries, which can take some time.
● Provides selection of the destination directories for the R&S NRPV application files.
● Checks whether a current version of the R&S NRP‑Toolkit is installed on the com-

puter. If not a message appears:

2.2.3  Uninstalling R&S NRPV

To uninstall a version of R&S NRPV, use the PC´s control panel:

1. In the Windows search, enter "Add or Remove Programs".

2. In the dialog, select NRPV entry.

3. To uninstall the program, select "Uninstall".

Software
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2.2.4  Power sensors firmware

The R&S NRPV works closely leaned on the functionality of the power sensors. The
program checks the firmware version of each connected sensor, and returns a list of
the power sensors that require a firmware update.

How to update the sensor firmware is described in the user manual of the power sen-
sor.

2.3  Connecting an R&S power sensor to the PC

There are different ways for connecting an R&S power sensor to a PC. The following
sections show some basic test setups with R&S NRP‑Z power sensors, but they apply
the same way to products of the NRP power sensors. For sensor-specific information,
see the user manual of the used power sensor.

Make sure that all power sensors are connected to the PC when starting R&S NRPV.
For Information on how to check that a power sensor is working properly see Sec-
tion 6.2.1, "Check if a power sensor is working properly", on page 167

If you connect an R&S power sensor to the PC for the first time, the application installs
the USB driver for the sensor automatically. The installed R&S NRP‑Toolkit provides
the USB drivers.

Connecting an R&S power sensor to the PC
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2.3.1  Single measurement setup

Figure 2-1: Measurement setup with a R&S NRP‑Z4 passive adapter cable

Figure 2-2: Measurement setup with an R&S NRP‑Z3 active adapter cable

1. Connect the power sensor with the USB port of the PC using the R&S NRP‑Z3 or
R&S NRP‑Z4 adapter cables.

2. Connect the signal source (DUT - device under test) and the power sensor.

Connecting an R&S power sensor to the PC
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2.3.2  Multiple measurement setup

Figure 2-3: Multiple measurement setup with a USB 2.0 hub

If an application works with more than one power sensor, you probably need a USB
hub. It is recommended that you use an R&S NRP‑Z5 sensor hub that perfectly fits to
R&S power sensors.

1. Connect the power sensor and the USB hub using the R&S NRP‑Z3 or
R&S NRP‑Z4 adapter cables

2. Connect the upstream port of the USB hub to a USB port of the PC.

3. Connect the signal sources and the power sensors

The following section provides additional information related to the USB interface and
information on operating multiple sensors simultaneously.

Multiple sensors

If multiple sensors need to be connected to one computer, make sure that the USB
device can provide the required amount of current for all sensors. A sensor needs
between 300 mA and 500 mA.

Example:

The R&S NRP‑Z8x sensor needs up to 500 mA supply current. Using 4 sensors simul-
taneously on one USB hub requires a total current of at least 2 A.

Even if the rated current values are given in the specifications, commercially available
USB hubs often do not reliably provide this amount of supply current over a long period
of time.

Connecting an R&S power sensor to the PC
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It is recommended that you use the R&S NRP‑Z5 sensor hub, a 4-port USB hub
adapter box, which perfectly fits to R&S power sensors.
Otherwise, for industrial-grade applications USB hubs for DIN rail mount can provide
up to 1 Ampere per USB port and run off a 24 V power supply.
The following manufacturers provide such devices:
● Beckhoff www.beckhoff.com CU8005
● Luetze www.luetze.de 745581 DIOHUB USB 4

2.3.3  Complex measurement setup

Figure 2-4: Complex measurement setup with a 4-port R&S NRP‑Z5 USB hub

1. Connect the plug-in power supply

2. Connect the external trigger source

3. Connect the power sensor and the USB hub using the R&S NRP‑Z3 or
R&S NRP‑Z4 adapter cables

4. Connect the signal sources and the power sensors

Connecting an R&S power sensor to the PC

https://www.beckhoff.com
https://www.luetze.de
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2.4  Starting the R&S NRPV software

License required
For using the R&S NRPV with the NRP power sensors, you do not need a license key.
You can use the R&S NRPV and all its functions for free.
For power measurements with power sensors of the R&S NRP‑Z power sensors, you
have to purchase a license key for each sensor. Contact the Rohde & Schwarz sales
department for purchase. The license key comes with instructions on how to activate
the power sensor in the Virtual Power Meter.
If you have already purchased a license, refer to Section 2.5.1, "Activating with
license", on page 16 for activating your sensor in the R&S NRPV.
If a sensor is connected without a license, you can activate the sensor temporarily, for
example, to explore the functionality of the software. See Section 2.5.2, "Activating
without license for temporary use", on page 18.

To start the R&S NRPV, perform one of the following:
● In the Windows search, enter "NRPV Virtual Power Meter".
● On the desktop, select the "R&S NRPV" icon.

The icon is automatically created during installation.
● In the Windows Explorer,

select ...\Program Files (x86)\Rohde-Schwarz\NRPV.exe.

Immediately after turning on the start screen appears until the application is ready for
operation. The application opens in a specific preset configuration, see Section 5.2.2,
"Startup configuration", on page 70.

Starting the R&S NRPV software
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Figure 2-5: Startup Screen

R&S NRPV startup configuration
In this dialog you can select the following startup configuration:
● The last active state
● A user-definable mode, specified in a task file.
● Default settings

2.5  Activating an R&S power sensor in R&S NRPV

While the NRP power sensors contain an activation key for the R&S NRPV as a factory
default, the R&S NRP‑Z power sensors need to be activated for the use with
R&S NRPV.

If you have already purchased a license key for your R&S NRP‑Z sensor, proceed as
described in the following section. Alternatively, you can activate a sensor without a
license temporarily, to explore the functionality and scope of the Virtual Power Meter.

2.5.1  Activating with license

In the delivery, you find a license key that unlocks your power sensor in the
R&S NRPV. If you want to perform tasks with several power sensors, you need a
license key for each sensor.

Activating an R&S power sensor in R&S NRPV
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To activate the sensor, proceed as follows:

1. Start R&S NRPV.

2. Connect the sensor.

3. In the "File" menu, select "File > Licensing"

Figure 2-6: File > Sensor licensing

The "Licensing NRP-Z Power Sensors for NRPV" dialog opens.

Figure 2-7: Licensing NRP-Z power sensor for R&S NRPV

The dialog indicates all currently connected sensors for selection.

4. Select the sensor.

5. Select "Enter License".

The "License Activation" dialog opens.

Figure 2-8: License Activation

6. Enter the license key either manually or with the keycode file.

7. Confirm with "OK" to return to the "Licensing NRP-Z Power Sensors for NRPV" dia-
log.

Activating an R&S power sensor in R&S NRPV
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Figure 2-9: Licensing NRP-Z power sensor for R&S NRPV > completed

Are there still sensors listed, repeat the process for each one, provided you have
the appropriate number of licenses.

The "<No unknown sensor found>" message confirms that no unlicensed sensor is
connected.

All sensors are enabled and ready for operation with R&S NRPV.

2.5.2  Activating without license for temporary use

If you want to evaluate the R&S NRPV before buying a license for your power sensor:

1. In the "File" menu, select "File > Licensing"

The "Licensing NRP-Z Power Sensors for NRPV" dialog opens.

2. Select "Evaluate Without License…"

Figure 2-10: Licensing NRP-Z power sensor for R&S NRPV > evaluate without license

The "Input Text" dialog opens and displays a code sequence for activation.

Activating an R&S power sensor in R&S NRPV
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Figure 2-11: Licensing NRP-Z power sensor for R&S NRPV > code without license

The code is generated randomly and changes with each new call.

3. Enter the displayed "Code" string exactly as shown in the "Input Text" dialog box.
The coding is case-sensitive.

4. Confirm with ok.

This function activates your power sensor for a time period.

Power sensors that are enabled temporarily show a thin red bar beneath their icon
in the program’s status bar. The length of this bar decreases until the evaluation
period is expired.

Activating an R&S power sensor in R&S NRPV
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3  Quick start guide
This section introduces the graphical user interface and contains some basics to power
measurement.

An instruction for a standard measurement of continuous average power takes you
step by step through the information required to get used to the R&S NRPV basic
modes of operation.

The quick start guide contains:
● Section 3.1, "GUI overview", on page 20

Describes briefly the main components of the user interface. In general, the
menus, dialogs and functions are largely self-explanatory. Characteristics to spe-
cific applications or settings are explicitly stated.
For detailed information on every item of the GUI refer to Section 4.1, "Graphical
user interface (GUI)", on page 43.

● Section 3.2, "Basic information on power measurement", on page 25
Contains some information on power measurement for RF and microwave signals.

● Section 3.3, "Trying out R&S NRPV", on page 27
Describes how to get started by selecting the power sensor, the signal channel,
configuring the test signal and the results display.

3.1  GUI overview

Starting the R&S NRPV software the main application window opens. The appearance
is based on the Microsoft Windows layout. Measurements are displayed in additional
windows. The appearance of those windows varies, depending on the measurement
mode and the required settings.

3.1.1  Windows

Main Application window

The main window of the application covers a menu bar with several drop-down menus
and a toolbar with icons of the most important functions. Similar to Microsoft Office
functionality, the icon buttons are the alternative possibility for starting a function. The
status bar informs about the connected power sensors and the currently active tasks.

GUI overview
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Figure 3-1: Main application window

1 = Menu bar
2 = Toolbar
3 = Numerical measurement window
4 = Graphical measurement in trace mode
5 = Control panel of trace mode measurement
6 = Measurements panel of trace mode
7 = Status bar of connected sensors
8 = Graphical measurement in statistics mode

Measurement windows

Measurement windows look different depending on the measurement mode. It is distin-
guished between numerical and graphic measurement windows.

GUI overview
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Figure 3-2: Numeric measurement window of R&S NRPV

Figure 3-3: Trace window of R&S NRPV

Measurement windows are tiled in several sections.

In the display area, you can graphically display the measurement results. On the right,
the control panel provides softkeys for accessing further dialogs and entry fields with
measurement related settings. In the lower area of the window, measurement panels
indicate numerical measurement results.

Also, you can open a context-sensitive menu within each results display, also providing
access to further functions.

GUI overview
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3.1.2  Dialogs

Configuration dialogs are designed in Microsoft Windows format, covering the same
main elements, e.g. tabs, entry fields, checkboxes or buttons. Each dialog provides
buttons to apply, confirm or cancel the entered settings.

Configuration dialog

Figure 3-4: Configuration dialog

Configuration dialogs cover entry fields for measurement related settings.

3.1.3  Menus

The menu bar of R&S NRPV contains the main menu items. Some items include sub-
menus with additional functions.

Figure 3-5: Menu bar

The following main menus are available:
● "File": Contains all functions that belong to file management.
● Configure: Contains basic parameters for configuring a measurement, such as fre-

quency, channel settings or predefined digital communication signals. In addition,
you can determine the colors for displays and curves individually.

● "Trigger": Contains the functions for setting the parameters of externally connected
trigger sources.

● "Measure": Menu for selecting the measurement mode.
● "Zero": Menu for zero error correction.
● "Window": Menu that contains the functions for window handling.

GUI overview
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● "Help": R&S NRPV Help.

► To access a menu, use the mouse or the [ALT+<key>] combination on the key-
board.

Figure 3-6: Standard menu

Within the results display of a measurement window, you can also access the configu-
ration dialogs or additional functions via context-sensitive menus.

► To access a context-sensitive menu, right click in a measurement window.

Figure 3-7: Context-sensitive menu

See Section 4.1.6.2, "Context-sensitive menus", on page 57 for detailed informa-
tion.

GUI overview
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3.1.4  Toolbar

Figure 3-8: Toolbar

The toolbar of the main application window covers icons of the most important func-
tions.

► To start a function of the R&S NRPV toolbar, perform one of the following:

● In the toolbar, select the corresponding icon.
● On the keyboard, use the associated shortcut.

Each icon features a corresponding item in the menu lists. For detailed assignment on
icons and shortcuts to the corresponding functions, see Section 4.1.7, "Icons, toolbar
and shortcuts", on page 58.

3.2  Basic information on power measurement

The following sections contain some basics to power measurement for RF and micro-
wave signals.

Some contents of the following sections are taken from the R&S document 'Voltage
and Power Measurements - Fundamentals, Definitions, and Products'. You can find the
document for download on the R&S Website www.rohde-schwarz.com.
.

3.2.1  Introduction

The intensity of RF and microwave signals is given in terms of power. Therefore, mea-
suring electrical power is significant for RF and microwave applications.

Basic information on power measurement

https://www.rohde-schwarz.com
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With the development of carrier-based telecommunications also the measurement of
power, voltage and current has improved. Based on converting electrical energy into
heat, direct voltage and current measurement can be made up into the GHz range.

Voltage and current are less appropriate because they depend on the physical charac-
teristics of the transmission medium and field strength. They differ at the same transmit
power. Also, voltage and current cannot directly be measured in waveguides and for
standing waves large measurement errors occur.

The rate of energy flow, the power, is the measurable value of the wave intensity. In
high frequency ranges, the wavelength of the electromagnetic field affects the wave
properties and characteristics caused by lines and subassemblies. To be considered
for power measurement, the wavelength and magnitude of the electromagnetic field
are of the same order as the signal wavelength. Also, all components in a power trans-
mitter or amplifier, e.g. the AC line connector, the cooling system or coaxial RF output,
depend on the magnitude of the RF power.

Besides the effects mentioned above, several critical factors can cause errors in the
measurement of RF power. For instance, the loading effects of measuring equipment
on the DUT, inherent physical factors or unsuitable probes can increase measurement
uncertainty.

To carry out a power measurement correctly, it is essential to assort the most appropri-
ate measurement equipment for the respective application. For a wide variety of tasks,
Rohde & Schwarz provides suitable power meters and power sensors.

3.2.2  Definition of electrical power

Power is defined as the amount of energy absorbed or transferred in a system per unit
of time. The power transmitted across an interface is then the product of the instanta-
neous values of current and voltage at that interface.

p(t) = v(t) x I(t)

For sinusoidal signals encountered in RF and microwave engineering, the instantane-
ous power p(t) oscillates about the average power at a frequency that is twice that of
the original waveform. Only the average power can be measured in practice and is
referred to as power P. P is referred to as active power and is related to the RMS volt-
age V, the RMS current I and the phase φ by the following equation:

P = V x I x cosφ

For modulated sinusoidal signals, the average of P over the modulation period is called
the average power Pavg

This power is indicated by a thermal power meter (sensor), for example.

3.2.3  Units and power level

Electrical power is measured in W [Watt]. Because of the large power ranges that have
to be measured, values are usually expressed as the log of a power ratio. A relative

Basic information on power measurement
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power level Ly is expressed in terms of the log of the ratio of power P to an arbitrary
reference power P0. The units of the power ratios are dB.

Ly = 10 log10 (P/P0) dB

Labs = 10 log10 (P/P0) dB

The absolute power level Ly refers to 1 mW and is measured in dBm:

Labs = 10 log10 (P/1 mW) dB

P = 1 x 10 Labs/10dBm mW

See the following list of the corresponding absolute and relative power level values in
the range 1018:
Table 3-1: Units and power level

Power P Level Labs [dBm] Power Ratio

1 pW -90 10-9

1 nW -60 10-6

1 µW -30 10-3

0.1 µW -10 0.1

0.25 mW -6 0.25

0.5 mW -3 0.5

1 mW 0 1

2 mW +3 2

4 mW +6 4

10 mW +10 10

100 mW +20 100

1 W +30 103

1 kW +60 106

1 MW +90 109

3.3  Trying out R&S NRPV

This section describes briefly how to set up a basic power measurement, by using an
R&S signal generator as a signal source and a power sensors as the measuring instru-
ment.

Because the power measurement system is to be terminated, the power sensor also
acts as the load, set up without external triggering and power supply. Source and load
are connected to a standard coaxial transmission line with the characteristic impe-
dance. The signal source generates an RF test signal. The R&S NRPV indicates the
signal power measured by the power sensor. The sensor runs with continuous initiali-

Trying out R&S NRPV
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zation enabled and thus sends measurement results without waiting for any trigger
events.

In continuous average mode, the average signal power is continuously measured. The
measurement window and the signal are not synchronized.

During the measurement period, samples are measured at equal intervals. The results
of two adjacent measurement windows are combined. The average of both can be out-
put as the final result or used as an intermediate result for further averaging.

Not all power sensors support all the examples described below.

3.3.1  Setting up the measurement

1. Check that the required system components are available as listed below:

● PC
● R&S power sensors
● R&S signal generator
● R&S NRP‑ZKU cable for the NRP sensors or R&S NRP‑Z4 passive adapter

cable for the R&S NRP‑Z power sensors

2. Check that the system is set up as required.
For the NRP power sensors set up the measurement system as described in the
user manual of the sensor.
For R&S NRP‑Z power sensors, set up the measurement system as described in
Section 2.3.1, "Single measurement setup", on page 12

3. Check that the PC is ready for operation. Install all software components as descri-
bed in Section 2.2.2, "Installing the R&S NRPV virtual power meter software",
on page 9.

4. Switch on the R&S Signal Generator.

5. On the PC, start the R&S NRPV software.

6. Check if the power sensor has reached its operating temperature.

3.3.2  Generating the test signal

An RF signal with 1 GHz and 0 dBm level is generated, in accordance with the digital
signal standard GSM, a worldwide used TDMA standard for cellular mobile radio net-
works.

For setting the signal parameters on your generator, proceed as follows:

1. Activate the default (preset) state for starting from a known position.

2. Select and activate a digital standard signal.
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3. Set the signal level and frequency.

4. Activate the signal output.

3.3.3  Measuring the average power

3.3.3.1  Configuring the channel, sensor and signal frequency

Configure the channel settings

To configure the channel settings, perform the following steps:

1. Select "Configure > Channel Assignment"

Figure 3-9: Context-sensitive menu

Figure 3-10: Channel assignment dialog

2. In the "Channel Assignment" dialog, assign a short name to a channel
By default, each channel is assigned a capital letters.

Figure 3-11: Channel assignment > assigned name
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At a maximum you can assign three letters, as for example "IN" or "OUT". Right
next, to the channel, R&S NRPV shows the sensor type, its serial number and con-
nectivity of the connected sensor.
Note: With one power sensor connected, the R&S NRPV automatically assigns the
power sensor to channel A.
If more sensors are connected, proceed as follows:

a) Select the channel intended for measurement.
b) Assign the short name OUT.
c) Select "Apply" to assign the selection.

If the channel is already active, skip these steps.
d) Close the dialog with "OK".

Initializing the power sensor

To prevent any previous settings from causing incorrect results, always run a new mea-
surement with a reset of the sensor.

To initialize the power sensor, proceed as follows:

1. Turn off the test signal before zeroing.
An active test signal during zeroing causes an error because the measured power
is too high.

2. Select "Zero > Select > OUT" (channel short name)

Figure 3-12: Zero channel

Zeroing starts in channel "OUT". This procedure checks the confidence level of the
sensor results.
Zeroing takes several seconds. At runtime, a "Zeroing in progress..." message is
displayed. When completed, the message terminates zeroing successfully or
reports an error (Success / Failed).

Figure 3-13: Zeroing in progress

Setting the frequency

The carrier frequency of the applied signal must be set to reach the specified measure-
ment accuracy.
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1. To set the frequency, select "Configure > Signal Frequency...".

Figure 3-14: Configure > Signal frequency

Figure 3-15: Signal frequency dialog

The "Signal Frequency" dialog opens, where you can determine the signal fre-
quency. The frequency value of the selected channel is indicated.

2. Select the channel.

3. Enter 1.0 GHz signal frequency.
Tip: Use a dot as a decimal separator.

4. Select "Apply" to assign the entry.

5. Close the dialog with "OK".

3.3.3.2  Configuring the measurement window

Setting up the measurement window

A measurement comprises at least two measurement windows, i.e. 2 x aperture time
and a sensor specific dead time of up to 100 µs.
By default a power sensor is set to an aperture time of a few microseconds to minimize
the inherent noise component in the measurement result. For an unmodulated signal,
as it is in this example, the default setting of 10 µs in conjunction with chopper stabili-
zation provides optimum noise suppression.

To set up a continuous average measurement window, proceed as follows:

1. In the menu bar, select "Configure > Continuous".
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Figure 3-16: Configure > Continuous

Opens the Continuous Average dialog to enter the aperture time and to activate
smoothing.

Figure 3-17: Configure Continuous > Aperture time

2. Select the channel.

3. In the "Aperture" entry field, enter 10 µs.

The aperture time defines the size of the measurement window. The aperture time
of the selected channel is indicated.

4. Select "Apply" to assign the entry.

5. Close with "OK."

3.3.3.3  Execute measurement

1. Start the measurement

a) To start the measurement, switch on the test signal of the signal source.

Trying out R&S NRPV



Quick start guideR&S®NRPV

33Manual 1173.0314.02 ─ 09

b) In the menu bar, select "Measure > Continuous".

Figure 3-18: Measure menu

The "Continuous" measurement window appears. It is shows the measurement
results numerically, and the control panel for accessing further dialogs with param-
eters for measurement, evaluation and display.

Figure 3-19: Continuous window

The measurement result is displayed in dBm as the default unit setting for continu-
ous average power measurement.

2. Change the unit of the measurement result.
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a) In the "Continuous Window", select "Meas..." to open the "Measurement Con-
figuration" dialog.

Figure 3-20: Configuration > Continuous window

b) Select the "Unit" tab in the lower area of the dialog.
c) Select "W" in the "Absolute" selection list.
d) Click "Apply" to assign your entry.
e) Confirm with "OK".

Figure 3-21: Continuous window > results in [Watt]

The measurement result is displayed in [W].

3. Set a fixed offset correction.
If the signal level is higher than the permissible input level of the sensor, connect
an attenuator between the signal source and the sensor to prevent the sensor from
damage. To adjust the attenuation, set an offset correction value. This value com-
pensates the difference between the real signal level and the level at the sensor´s
input. The indicated value corresponds to the real signal level.
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a) In the menu bar, select "Configure > Channel Settings".

Figure 3-22: Configure > Channel settings

b) Select the channel.

Figure 3-23: Channel settings dialog

c) In the "Offset" section, select "Global".
d) Enter the associated attenuation value.
e) Select "Apply" to assign your entry.

Note: To make sure that the devices perfectly match, we recommended to use
only an R&S attenuator.

f) Confirm with "OK".

4. Measure power relative to a reference value.
The R&S NRPV calculates and displays relative differences between a measured
value and a reference value. As a reference, you can use a previously stored
value, or you can specify it directly.
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a) In the "Continuous Window", select "Meas..." to open the "Measurement Con-
figuration" dialog.

Figure 3-24: Configuration > Continuous > Unit

b) In the "Unit" tab, select "dBm" for the absolute value.
c) In the "Relative" tab, activate the "Relative".
d) Enter -10 dBm"Ref. Value".

Figure 3-25: Configuration > Continuous > Relative
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e) Select "Apply" to assign your entry.

Figure 3-26: Continuous window > reference value indication

f) Confirm with "OK".

The diagram indicates the set reference value and the measured value relative to
this reference, in this example -10 dBm. That means, the level of the applied signal
is -26 dBm. The relative difference between the measured value and the -10 dBm
reference value is -16 dBm.

5. Configure the display

a) In the "Continuous Window", select "Display..." to open the "Display Configura-
tion" dialog.

Figure 3-27: Display Configuration > continuous window name

In this dialog, you can assign a name window name.
b) Enter the name, for example 1 GHz, GSM - Continuous Av.
c) Select "Apply".

Figure 3-28: Continuous window > window renamed

d) Confirm with "OK".
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3.3.3.4  Graphically representing power versus time

Trace and statistics modes represent graphically the measured power versus time. Dis-
playing the signal graphically as with an oscilloscope, trace mode is particularly suita-
ble for recognizing stable triggering of modulated signals during measurement.

Set the trace mode.

1. Apply an amplitude-modulated or pulsed signal with a modulation or pulse fre-
quency of 1 kHz and 0 dBm signal level.

2. To configure trace mode, select "Measure > Trace" in the menu bar.
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Figure 3-29: Select trace mode

Figure 3-30: Trace window
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Opens the "Trace" window. It shows the measured signal power graphically. The
control panel provides access to settings dialogs for configuring the trace, mathe-
matic functions, the diagram and marker. Also, you can configure the display set-
tings like scale, power, time and trigger. In the lower area of the window, the mea-
surement panel indicates numerical measurement results. For a detailed descrip-
tion on trace measurement and the associated functions, see Section 5.4.2,
"Trace", on page 94.

3.3.3.5  Math configuration

"Math Configuration" includes operands selection for math measurement of maximum
of four math channels, math operation selection, math channel selection for view, rela-
tive measurement option and reference value, selection of units and resolution and the
parameters that you want to display as auxiliary.

Figure 3-31: Math configuration dialog

Figure 3-32: Continuous window > math results indication

The R&S NRPV automatically tiles the window and shows the math results.
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3.3.4  Numerical burst average measurement

The burst average mode is used to measure the average power of pulsed signals. In
this example, a pulsed RF signal with a pulse repetition frequency not exceeding
10 kHz is used. The sensor automatically detects the start and end of a burst and the
trigger point from the measured signal. An external trigger is not required.

1. Set the measurement window.

a) Select "Configure > Burst Average..." in the menu bar.

Figure 3-33: Configure > Burst Average

Opens the "Burst Average" dialog for configuring the burst mode parameters.
Exclude from start and Exclude from end exclude pulse build-up and decay
phases of a pulse. Dropout increases the reliability of the end of the modulated
burst signal.
The values of the selected channel are indicated.

Figure 3-34: Configure > Burst Average dialog

b) Select the measurement channel.
c) Enter "Exclude From Start"0.001 s.

This parameter excludes the initial peaks of the signal from the measurement.
d) Enter "Exclude From Start" 0.002 s.

This parameter excludes fluctuations at the falling edge of the burst from the
measurement.

e) Select "Apply" to assign you entries.
f) Confirm with "OK".
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2. To start the measurement, select "Measure > Burst Average" in the menu bar.

Figure 3-35: Continuous window > Burst Av results indication
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4  Operating concept
This section provides an overview of the R&S NRPV. It describes the layout of the
application, special display features and controls, and how to operate R&S NRPV.

4.1  Graphical user interface (GUI)

Starting the R&S NRPV software opens the main application window. The appearance
is based on the Microsoft Windows layout.

At the top, the application window covers a menu bar with general and application-spe-
cific functions. An icons toolbar provides quick access to these functions.

In the display area, R&S NRPV shows the measurements. On the right of a graphical
or time-based measurement window, a control panel provides access to further func-
tions and measurement settings. The lower area of a measurement window indicates a
measurement panel with the numerical measurement results.

The status bar at the bottom shows the connected power sensors and the currently
active tasks.

Figure 4-1: Operating concept > main application window
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The operation corresponds to Microsoft Windows user interfaces. All menus, dialogs
and tables are made up of known elements, such as selection lists, checkboxes and
entry fields.

4.1.1  Specific features

4.1.1.1  Zoom

Convenient monitoring of individual readings
By double-clicking a value in a measurement panel, you can zoom out the value and
leave it permanently indicated on the display.

Figure 4-2: Operating concept > values zoomed out

You can zoom out a measured value arbitrarily and place it somewhere in the
R&S NRPV window. The panes of these readings are transparent, so that the overlap-
ping area remains visible.

4.1.1.2  Sensor info

You can display information on the power sensor quick and conveniently.
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1. Move the cursor on a sensor image in the status bar to get quick information on the
sensor type and its serial number, as shown in the figure below.

2. Double-click the sensor icon to open an information window with detailed informa-
tion to the sensor.

3. Readout or even copy this info, for example to have it at hand for service purposes.

4.1.1.3  Print or copy to clipboard

Using the right mouse button, a context-sensitive menu opens within each measure-
ment window. The context-sensitive functions enable you, e.g. to print the current read-
ings or measurement curves or save them in the clipboard for export.

Print
Displays a print preview of the corresponding measurement result.
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Table 4-1: Printout examples

Trace measurement Statistics measurement

Numerical measurement Timeslot measurement

Copy to Clipboard
Creates a screenshot of the current result window and temporarily stores it on the clip-
board. You can now insert this hardcopy in a document.
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Table 4-2: Printout examples

Trace measurement Statistics measurement

Numerical measurement Timeslot measurement

4.1.2  Application window

This section describes the specific R&S NRPV window components. Besides the main
application window, additional windows are opened according to the selected measure-
ment.

In general the application distinguishes between "Graphical measurement mode" and
"Numerical measurement mode", represented in results windows. Results are dis-
played digitally and graphically. A results window contains several areas. For example,
a display area, a control panel on the right, and, depending on the measuring mode, a
results table (measurement panel) which contains specific parameters. The numeric
measurement modes display the results digitally. In the graphic measurement mode
R&S NRPV displays the results graphically, including relevant information in the upper
range of the window. With the functions in the right panel, you can configure the
respective measurement window. A graphical measurement window also contains a
table that represents the values numerically.
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Menu bar

Enables you to select file management and measurement functions from listed items in
menus and submenus.

Figure 4-3: operating concept > menu bar

Menu

A menu displays a list of functions, with some of them visualized by icons. Find an
overview of functions with associated icons in Section 4.1.7, "Icons, toolbar and short-
cuts", on page 58.

Figure 4-4: Operating concept > menu

Toolbar

Enables you to execute functions by selecting the icon directly.

Figure 4-5: Toolbar

Status bar

The status bar displays the connected sensors, the channel they are assigned to (or
short name), and the current activity.

The background color of the sensor symbol represents the activity:

Indicates the active channel.

Indicates that the measurement in this channel is not active.
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4.1.3  Measurement windows

Measurement windows look different depending on the measurement mode. The appli-
cation distinguishes between "Graphical measurement mode" and "Numerical mea-
surement mode", represented in results windows. Results are displayed numerically
and graphically. A results window contains several areas, e.g. a display area, a control
panel on the right, and, depending on the measuring mode, a results table (measure-
ment panel) with specific parameters. The numeric measurement modes display the
results numerically. In the graphical measurement mode, R&S NRPV displays the
results as a trace curve or bar chart, including relevant information in the upper range
of the window. With the functions in the control panel, you can configure the measure-
ment and display parameters. In a graphical measurement window, the measurement
panel represents the results numerically.

A right click in the results window opens a context-sensitive that provides quick access
to further functions and settings dialogs.

4.1.3.1  Numerical measurement window

Numerical measurement windows indicate the measurement results numerically. On
the right, a control panel provides softkeys for accessing further dialogs, entry fields for
measurement settings, and the "Snapshot" button for saving settings.

Figure 4-6: Operating concept > measurement window in continuous mode

4.1.3.2  Graphical measurement window

Graphical measurement windows, as for example in trace or timeslot mode, are divi-
ded into three sections:
● The display area, containing the graph and a diagram description bar.
● The control panel on the right side with softkeys and entry fields.
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● The measurements panel underneath the graph.

Figure 4-7: Operating concept > measurement window in trace mode

Graphical user interface (GUI)



Operating conceptR&S®NRPV

51Manual 1173.0314.02 ─ 09

Figure 4-8: Operating concept > measurement window in timeslot mode

Several parameters as grid, reference arrows, scale labels, trigger, marker and level
information are provided to configure the diagram, depending on the selected mea-
surement mode. Refer to the respective descriptions to the results windows:
● Section 5.4.2.2, "Graph in trace mode", on page 97
● Section 5.4.3.2, "Graph in statistics mode", on page 124
● Section 5.4.4.2, "Results in numerical mode", on page 137 and Section 5.4.4.3,

"Graph in timeslot mode", on page 138

4.1.4  Measurement panels

Figure 4-9: Operating concept > measurement panels
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A measurement panel is arranged underneath the diagram. It consists of several tabs
that contain the significant parameters of the measurement. R&S NRPV displays the
current readings.

Conveniently adjusting of the measurement panel size
The width of the panel is fixed. However, you can change the height of the measure-
ment panel individually by dragging the frame accordingly.

4.1.5  Configuration dialogs

This section describes the structure of the application dialogs. The dialogs are also
designed in window format, covering the same main elements, e.g. entry fields, check-
boxes or buttons. Some entry fields are partially structured in tabs. Each dialog pro-
vides buttons to apply, confirm or cancel the entered settings.

The application mainly distinguishes between the measurement, math and display or
diagram configuration dialogs. Some measurement modes contain additional subme-
nus and dialogs for setting specific parameters, e.g. markers.

4.1.5.1  Measurement configuration dialogs

Table 4-3: Operating concept > Measurement configuration dialogs

Measurement configuration dialogs contain the entry fields for setting the parameters
of the currently selected measurement mode.
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4.1.5.2  Math configuration dialogs

Table 4-4: Operating concept > Math configuration dialogs

Math configuration dialogs contain math parameters and operands.

Depending on the selected measurement, the math configuration dialogs vary.

4.1.5.3  Display configuration dialogs

Figure 4-10: Operating concept > Display configuration dialog

A display dialog covers entry fields for configuring diagram parameters in numerical
measurement modes.
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4.1.5.4  Diagram configuration dialogs

Table 4-5: Operating concept > Diagram configuration dialog

A diagram dialog covers entry fields for configuring diagram parameters in graphical
measurement modes.

Depending on the selected measurement, the diagram configuration dialogs vary.

4.1.6  Menus

This section describes the menu structure of the application. Menus are designed in
window format and display a list of functions. Menus are opened with the aid of the
mouse or by using the [ALT+<key>] combination on the keyboard.

The following figure shows the available main menus of the application. For detailed
description of the menu items, refer to Section 5, "Settings - GUI reference",
on page 66.

4.1.6.1  Main menus and submenus

The main menus are located in the menu bar at the top of the screen.

Figure 4-11: Operating concept > menu bar

Graphical user interface (GUI)



Operating conceptR&S®NRPV

55Manual 1173.0314.02 ─ 09

A list item of a menu marked with an arrow, represents a general term and covers a
submenu.

Figure 4-12: Operating concept > submenus

R&S NRPV contains the following menus:

File

Figure 4-13: Operating concept > File menu

Contains all functions that belong to task management. Create, save or recall measur-
ing data or print the measuring results.

Configure

Figure 4-14: Operating concept > Configure menu

Graphical user interface (GUI)



Operating conceptR&S®NRPV

56Manual 1173.0314.02 ─ 09

Contains functions for setting the startup configuration, channel configuration and sig-
nal frequency. This menu also provides setting dialogs with basic parameters for all
measurement modes, and dialogs for loading settings of digital standard communica-
tion signals.

Trigger

Figure 4-15: Operating concept > Trigger menu

This menu is used for setting the parameters of an external connected trigger source.

Measure

Figure 4-16: Operating concept > Measure menu

Menu for selecting the measurement mode.

Zero

Figure 4-17: Operating concept > Zero menu

Menu for zero error correction.
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Window

Figure 4-18: Operating concept > Window menu

A Windows menu contains functions for window handling.

Help

Figure 4-19: Operating concept > Help menu

The help menu with access to the online help and information about the R&S NRPV
software version.

4.1.6.2  Context-sensitive menus

R&S NRPV provides special context-sensitive menus for each area of a measurement
window, except for measurement panels. Open a context menu by pressing the right
mouse button.

A context-sensitive menu within the graphic range mainly contains the functions of the
control panel.

The following figure gives an example of context-sensitive menus.

Figure 4-20: Operating concept > Context-sensitive menus
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For a detailed description of the available menus, see:
● Section 5.4.2.4, "Context-sensitive menu in trace mode", on page 98
● Section 5.4.3.4, "Context-sensitive menu in statistics mode", on page 125
● Section 5.4.4.4, "Context-sensitive menu for numerical measurement modes",

on page 139
● Section 5.4.4.5, "Context-sensitive menu in timeslot mode", on page 140

4.1.7  Icons, toolbar and shortcuts

4.1.7.1  Toolbar

The toolbar of the main application window contains icons for quickly starting the main
functions.

Figure 4-21: Operating concept > Toolbar

Each icon features a corresponding item in the menu lists. For assignment on the icons
to the corresponding functions, see Section 4.1.7.2, "Icons", on page 58.

4.1.7.2  Icons

To execute a task, the application provides icons for main and frequently used func-
tions.

► To start a measurement, perform one of the following:

● Select the  icon.
● Select "Measure > Continuous" in the menu bar.
● Press "F4".
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Figure 4-22: Operating concept > Icons

The following table lists the functions that can be started quickly by an icon, function
key or a specified keyboard sequence (shortcut):
Table 4-6: Icons and the corresponding functions

Icon Function Corresponding menu item Shortcut

New Task File > New Task Starting With -

Load Task File > Open Task CTRL+O

Save Task File > Save Task CTRL+S

Trace Measure > Trace F2

Statistics Measure > Statistics F3

Continuous Measure > Continuous F4

Gated Measure > Gated F5

Burst Average Measure > Burst F6

Timeslot Measure > Timeslot F7

Start Measurement Measure > Start All F10

Stop Measurement Measure > Stop All F11

Open data recorder Measure > Data Recorder F12

Trigger Settings Trigger > Settings … -

Channel Settings Configure > Channel Settings … -

Index Help > Index F1

4.1.7.3  Shortcuts

Shortcuts are a combination of keystrokes that provide quick access to commands,
functions or operations.
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Like the icons in the toolbar, the R&S NRPV has predefined key combinations that
invoke particular functions.

Figure 4-23: Operating concept > Shortcuts in menus

The following table lists the functions that can be started quickly by a shortcut:
Table 4-7: Shortcuts and the corresponding functions

Shortcut Function Corresponding menu item

[ALT+C] Cascade "Window > Cascade"

[ALT+Left] Active Previous "Window > Active Previous"

[ALT+Right] Active Next "Window > Active Next"

[ALT+T] Tile "Window > Tile"

[CTRL+A] Channel Assignment "Configure > Channel Assign-
ment"

[CTRL+B] Burst Average "Configure > Burst Average"

[CTRL+C] Continuous "Configure > Continuous Aver-
age"

[CTRL+G] Gates "Configure > Gates"

[CTRL+I] Statistics "Configure > Statistics"

[CTRL+O] Open Task "File > Open Task"

[CTRL+S] Save Task "File > Save Task"

[CTRL+T] Timeslots "Configure > Timeslots"

[CTRL+U] Pulse Measurement "Configure > Pulse Measurement"

[CTRL+X] Exit "File > Exit"

[CTRL+Z] All Channels "Zero > All Channels"
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4.1.8  Diagrams

Several parameters as grid, reference arrows, scale labels, trigger, marker and level
information are provided to configure the diagram, depending on the selected mea-
surement mode. Refer to the respective descriptions to the graphs:
● Section 5.4.2.2, "Graph in trace mode", on page 97
● Section 5.4.3.2, "Graph in statistics mode", on page 124
● Section 5.4.4.2, "Results in numerical mode", on page 137 and Section 5.4.4.3,

"Graph in timeslot mode", on page 138

4.1.8.1  Info and symbols

According to channel, measurement and math operation, the diagram description bar,
or the result fields in numerical measuring modes contain various information, some
shown as symbols. The indicated parameters, values and symbols are activated for
display in the corresponding configuration dialogs of the measurement. For example, a
measurement mode, numeric and auxiliary values, trigger, marker or filter values or
even warnings. They are each color coded, i.e. the color of a value corresponds to the
color of the measurement and the graph.

Refer to the following table to get an overview on some individual symbols:
Table 4-8: Special symbols

Icon Function

Duty cycle correction active

Offset correction active

S-parameter correction active

Trigger on rising slope

Trigger on falling slope

Waiting for trigger event

Info
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Icon Function

Error occurred

Warning, e.g. out of range

4.2  Means of manual operation

Operation of R&S NRPV corresponds to the Microsoft Windows user interface and can
be operated the same way. Mouse and keyboard, including shortcuts allow direct
access to entries and settings.

4.2.1  Entering data

Enter values, units and text by activating the entry field with the mouse and then use
the keyboard.

Numerous help functions, called by [F1] function key support the user in measurement
configuration.

Apply

Apply the settings to the current measurement without closing the active window.

Ok

Apply the settings and close the active window.

Cancel

Aborts the active window without applying the settings or saving the changes.

4.2.2  Elements

All menus, dialogs and diagrams are made up of known elements, e.g.

Means of manual operation
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Table 4-9: GUI Elements

User interface element Description

Menu items

In a menu a selection can be made from a list. The
selection list folds down by clicking the menu name.

Dialog header

The header line contains the name of the menu and
a button closing the menu. The button can be oper-
ated with the mouse.

Dialog area

Several fields of associated but separately set
parameters are organized in an area.

The dialog areas are separated from each other with
a frame.

Tab

Settings fields structured in separate tabs within a
dialog.

Selection field

The  button indicates that a selection can be made
from a list. The fold-down selection list is displayed
below the selection field.

One entry at a time can be selected from the list. If
an item is not available for selection, it is grayed out
and cannot be accessed.

Checkbox

If the checkbox is ticked, the associated parameter
setting is active (switched on).

Tool tip

Help function indicating an explanation to the cur-
rently selected element.

Numerical entry field

A numeric value can be entered.

Alphanumerical entry field

An alphanumeric value can be entered.

Color selection field

Opens a dialog for selecting a color.

Buttons

A button either triggers a single action or calls the
next menu.
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User interface element Description

Selecting field

Area for selecting the channel and the sensor,
respectively.

Status field

Indicates the state of either the currently running
task or the state of a connected sensor.

Scrollbars

Scroll within a dialog or window.

Hide/Show control in the splitter bar

Shows / hides a control panel or measurement
panel by mouse click the striped bar.

4.2.3  Mouse operation

Basically the mouse as a pointing device is similar to every computing system. This
section only touches information on some special features of the application.

Clicking the right mouse button performs context-sensitive menus for the following con-
trols:
● Channel traces
● Math traces
● Marker symbols
● Limit lines
● Trigger levels and symbols
● Vertical reference position symbol
● Residual screen area
● Trace window

4.2.4  Splitter bar

The control and measurement panels are separated from the diagram by splitter bars.
Each splitter bar contains a button to hide or show each panel.

Figure 4-24: Operating concept > Splitter bar

Means of manual operation
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The width of the control panel is fixed, whereas the height of the measurement panel is
flexible. Therefore the space between the diagram and the measurement table can be
shared by moving the splitter bar with the mouse.

4.3  Data management

R&S NRPV provides basic measurement settings, which are already stored in the
application. It also supports saving user-defined settings and measurement data. Usu-
ally drive C:\ is intended to save user-defined data, but you can also select any direc-
tory structure. Some default directories are predefined, as for example TaskFiles
that is recommended by the application. The filenames and directories are user-select-
able and can be changed.

The user data is divided into the following data types:
● Signal template

This file contains samples with basic measurement parameters predefined in the
application. See Section 5.2.14, "Load template", on page 87 to call predefined
settings.
Note: Templates refer to the default application settings and cannot be changed.

● Tasks
Task files contain settings of a measurement. See Section 5.1, "File menu",
on page 66 for handling with task files. For tasks files, the directory
%APPDATA%\Rohde-Schwarz\NRPV\TaskFiles\*.tsk is selected by default.

Data management
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5  Settings - GUI reference
"Settings" describes all dialogs and functions of the application in detail.

5.1  File menu

Figure 5-1: File menu > New Task Starting With...

The "File" menu contains all functions that belong to file management, like creating,
saving or recalling measurement data or printing the measurement results.

Task files are stored in the default directory
%APPDATA%\Rohde-Schwarz\NRPV\Taskfile\<taskname.tsk>.

In addition, the R&S NRPV application can be closed with the "Exit" function.

New Task Starting With...
Opens the submenu for selecting a measurement task.

Trace Window ← New Task Starting With...
Creates a task for measurement mode Section 5.4.3, "Statistics", on page 122.

Statistics Window ← New Task Starting With...
Creates a task for measurement mode Section 5.4.3, "Statistics", on page 122.

Continuous, Gated, Burst Average or Timeslot Window ← New Task Starting
With...
Creates a task for a numerical measurement mode.
The measurement windows of these modes are almost similar. The description in Sec-
tion 5.4.4, "Numerical", on page 135 applies to all modes. Special features are descri-
bed explicitly.

Open, Close, Save, Save As Tasks
Manages task files.
These functions are self-explanatory and similar to the Microsoft Windows file dialog.

File menu
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Note: The extension of a measurement task is *.tsk and cannot be changed. By
default, R&S NRPV saves the file in the
%APPDATA%\Rohde-Schwarz\NRPV\Taskfile\<taskname.tsk> directory.

Licensing
Opens the "Licensing NRP-Z Power Sensors for NRPV" dialog.
In this dialog, you can enable an R&S NRP‑Z power sensor for use with R&S NRPV,
see Section 2.5, "Activating an R&S power sensor in R&S NRPV", on page 16.

Note: All NRP power sensors are enabled for the use with R&S NRPV by default.

Recent Task Files
Lists the recently used task files. Select a task to reopen it.

Exit
Closes the application.
R&S NRPV requires a prompt for storing modified tasks, to save the last changes in
the task file.

5.2  Configure

Figure 5-2: Configure menu

The "Configure" menu contains functions for setting the startup configuration and func-
tions to configure channel assignment, channel settings and signal frequency settings.
The menu also provides access to dialogs for configuring VISA communication-based
sensors, basic parameters for all measurement modes, and predefined settings of digi-
tal standard communication signals.

Configure
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5.2.1  Functions

Startup Configuration
Opens the dialog for specifying the settings used at the start of R&S NRPV. Sec-
tion 5.2.2, "Startup configuration", on page 70. You can select between user-defined
settings (from a specified task file), settings of the last measurement, or by application
defined default settings.

VISA Sensor Configuration
Opens the dialog for managing all power sensors that use VISA communication chan-
nels like USBTMC or VXI-11. See Section 5.2.3, "VISA sensor configuration",
on page 70.
Note:
● This dialog is only available if a VISA driver is installed on the host PC.
● This dialog refers to the NRP power sensors. R&S NRP‑Z power sensors are not

provided by this function.
You can trigger a search for locally connected (VISA capable) USB power sensors that
are automatically taken over into the sensor list. Furthermore you can manually add
any number of network sensor resources.

Color Settings
Accesses the dialog for setting the colors, see Section 5.2.4, "Color settings",
on page 71. In this dialog you can design your measurement windows, i.e. you can
arbitrarily assign colors to the traces, curves and markers, and to background and grid
lines of diagrams.
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Channel Assignment
Opens the dialog for selecting and assigning the channel, see Section 5.2.5, "Channel
assignment", on page 72. This dialog covers information on the connected power
sensors and its connectivity.

Signal Frequency
Opens the "Signal Frequency" dialog for setting the carrier frequencies of the signals,
see Section 5.2.7, "Signal frequency", on page 79.

Channel Settings
Opens the dialog for configuring a channel, see Section 5.2.6, "Channel settings",
on page 73. Channel settings include offset, video bandwidth, gamma and S-parame-
ter correction, ranging, and averaging.

Measurement Modes
The following topics provide dialogs to configure basic signal parameters that are inde-
pendent of the used power sensor. These parameters represent the global settings and
are needed in principle with the respective measuring modes. Changes of these set-
tings are saved in task files.
Note: See also Section 5.2.14, "Load template", on page 87 to recall predefined set-
tings based on a measurement mode or based on a digital standard communication
signal.

Figure 5-3: Configure menu > Load template

Continuous...
Continuous opens the dialog for configuring the measurement window settings as
aperture time, sampling frequency and smoothing.
Note: For trace and statistics measurement mode, the signal frequency is displayed in
the Section 5.4.2.3, "Diagram description bar", on page 98.

Burst Average...
The Burst average contains excluding times and dropout.

Statistics...
Opens the Statistics for setting the aperture time.

Timeslots...
Opens the dialog Timeslots for configuring timeslot and fence parameters.

Gates...
Gates opens the dialog for configuring gate and fence parameters.
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Pulse Measurement...
Selects the algorithm for evaluating pulse signals and set the threshold parameters in
the dialog Pulse measurement.

Load Template...
Opens the dialog Load template for loading predefined settings of or CW signals, or
digital standard communication signals like GSM.

5.2.2  Startup configuration

This function enables you to determine the initial configuration of R&S NRPV at
startup.

Figure 5-4: Configure > Startup Configuration dialog

NRPV Configuration for Startup
Opens the dialog for selecting how the R&S NRPV starts.

"Last Active Settings"
Starts in the same mode, which was active during the last measure-
ment.

"User Defined Settings"
Starts in a user-defined mode, which was previously specified and
saved in a task file.

"Default Settings"
Starts with preset values.

5.2.3  VISA sensor configuration

In this dialog, you can define any number of VISA sensors by adding the VISA
resource name. You do not need to connect a sensor while defining it here. From the
list of possible sensors, you can select which ones are to be used later in R&S NRPV
measurement windows by activating the checkbox in the "Use" column.
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The dialog also provides functions to edit a selected VISA resource name or to remove
entries from the defined list. You can double-click a resource name to edit it. Further-
more you can easily add all currently connected USB sensors to the list clicking the
"Find USB Sensors" button.

When you close the dialog with "OK", the configuration dialog tries to find and open all
sensors that have been selected for measurements through an activated checkbox in
the "Use" column. All sensors that can be reached via the defined VISA communica-
tion channel are added to the program's internal list of available sensors. The available
sensors can then be assigned to measurement windows in the corresponding mea-
surement dialogs. Sensors that are marked here with the "Use" flag but are not availa-
ble physically, are ignored.

5.2.4  Color settings

In this dialog, you can individually assign colors to traces and curves, including the
associated markers, and to background and grid lines of diagrams.
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Figure 5-5: Configure > Color Settings dialog

In "Color Settings" select individual colors for your measurements, or set all colors to
default.

Color Settings...
Opens a dialog to set the colors.

5.2.5  Channel assignment

The "Channel Assignment" dialog displays all connected sensors with information on
the sensor type, serial number and connectivity.
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Figure 5-6: Configure > Channel Assignment dialog

With one power sensor connected, the R&S NRPV program automatically assigns the
power sensor to channel A.

Channel Name
Lists the connected channels.

Figure 5-7: Configure > Channel assignment > Rename

The R&S NRPV detects all connected sensors automatically and applies capitals to
each channel in alphabetical order.
You can assign a short name to a channel. The maximum length is three characters in
capital letters, as for example "IN" or "OUT".

Sensor Type, Serial Number & Connectivity
Displays information on the connected sensors.
"Current" Displays information on the currently connected sensor.
"Previous" Displays information on the previously connected sensor.

5.2.6  Channel settings

The "Channel Settings" dialog covers entry fields for setting sensor channel parame-
ters.
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Figure 5-8: Configure > Channel settings dialog

The dialog contains sensor related parameters.

The parameters are grouped by functionality, such as "Offset", "Video bandwidth", "S-
Parameter" and "Gamma" correction, "Ranging" and "Averaging". If a sensor does not
support a certain functionality, the corresponding controls are disabled.

Channel
Selects the channel.

Offset
Note: If the signal level is higher than the permissible input level of the sensor, it is rec-
ommended that you connect an attenuator between the signal source and the sensor.
The attenuator prevents the sensor from damage due to high input power. The offset
correction compensates the difference between the real signal level and the level at
the sensor input. The indicated value corresponds to the real signal level.
Enter and activate correction factors to increase or decrease the measurement result
value. Correct only factors, which do not, or only minimally depend on frequency or
level. For example, use this function to adjust attenuators, directional couplers or
amplifiers that are connected between the signal source and the sensor.
Positive offset values correspond to external losses, negative values to external gains.
The symbol  indicates that the offset correction is active.
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Global ← Offset
Activates the offset correction globally for all frequencies with the entered value.

0.000 ← Offset
Sets the global offset value. That means the offset for all frequencies.
R&S NRPV automatically adjusts the trigger level when the offset correction values
vary. When prompted, confirm the adjustment.

Figure 5-9: Configure > Channel settings > Automatic trigger level update

File ← Offset
Selects a file with offset correction data.
A file contains a table with frequency/offset pairs.
The extension of a correction file is *.s1p, or *.txt. If there is an *.s1p, the file con-
tent must conform with the touchstone file specification. You can look up the touch-
stone file specification in https://www.wikipedia.org/. The correction files are stored in
the application data directory %APPDATA%\Rohde-Schwarz\NRPV\<*.s1p>.

Video Bandwidth
Sets the video filter bandwidth.
This parameter is supported by R&S NRPxP and R&S NRP‑Z8x wideband power sen-
sors.
You can use this value to reduce the video bandwidth in trace and statistics measure-
ment modes. As a result, the trigger sensitivity is increased and the display noise
reduced. In order not to distort the signal, the video bandwidth must be smaller than
the RF bandwidth of the measurement signal.
A limited video bandwidth also reduces the sampling rate. Therefore, in trace mode,
the effective time resolution is reduced accordingly. In statistics mode, the measure-
ment time must be increased appropriately to keep the required sample size. The fol-
lowing table shows the video bandwidth and the resulting sampling rate and sampling
time interval by the example of an R&S NRP‑Z8x power sensor.
Table 5-1: Video bandwidth and sampling rate

Video Bandwidth Sampling rate Sampling time interval

FULL 8 x 107 s-1 12.5 ns

5 MHz 4 x 107 s-1 25 ns

1.5 MHz 1 x 107 s-1 100 ns

300 kHz 2.5 x 107 s-1 100 ns
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"FULL" For frequencies from 500 MHz on, FULL corresponds to a video
bandwidth of at least 30 MHz. For frequencies below 500 MHz, the
video bandwidth is automatically reduced to approx. 7.5 MHz.

"x MHz" The video bandwidth is set to the selected value.

S-Parameter Correction
Selects and applies a data set of S-parameters (available only for sensors that support
S-parameter correction).

Figure 5-10: Configure > Channel settings > S-parameter

In the Info line of the measurement window, the symbol  indicates that the S-parame-
ter correction has been activated.
S-parameters are used to correct measurement results that are influenced by a two-
port connection. If a complete set of S-parameters is available in the power sensor, the
measurement can be corrected by way of calculation.
Note that a reference impedance of 50 Ohms must be used for the S-parameters.
For information on how to use the S-parameters table, see the user manual of your
power sensor.

Gamma Correction
Increases the measurement accuracy by either setting the magnitude and phase of the
source's reflection coefficient, or alternatively, the real and imaginary source.
The gamma correction value sets the complex reflection coefficient of the source. A
magnitude value of 0 is equivalent to an ideally matched source, and 1 corresponds to
total reflection. The phase angle can be set between -360.0 degrees and +360.0
degrees.

Apply ← Gamma Correction
Save gamma correction settings.

Single Frequency ← Gamma Correction
Activate/deactivate gamma correction with the set values.

Re. source ← Gamma Correction
Set the real part, i.e. the magnitude of the source reflection coefficient.

Im. source ← Re. source ← Gamma Correction
Set the imaginary part, i.e. the phase of the source reflection coefficient.

Magn. source ← Gamma Correction
Set the magnitude of the source reflection coefficient directly.

Phase source ← Magn. source ← Gamma Correction
Set the phase of the source reflection coefficient directly.
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File ← Gamma Correction
Select the file with gamma correction data and activate the gamma correction with data
from that file.
A file contains a table with magnitude/phase pairs. The extension of a correction file is
*.s1p or *.txt. By default correction files are stored in the application data directory.

Ranging
Select the measurement path for multipath power sensors.
Multipath power sensors are equipped with several paths, providing different sensitivi-
ties and therefore different measurement ranges. The measurement paths are simulta-
neously active.

Auto ← Ranging
Activate automatic selection of the suitable path, i.e. paths that are not overdriven or
underdriven. The measurement result of two partially overlapping measurement paths
is derived from the measured values of both paths.
For some applications, e.g. test signals with a large peak-to-average ratio, measuring
with "Auto Ranging" does not lead to accurate measurement results. Use the cross-
over function, which lowers the level in the crossover, to prevent an overdriven mea-
surement path from distorting the evaluation.

Transition Offset ← Ranging
Reduce crossover range. To prevent measurement paths that have been overdriven by
signal peaks from being included in the evaluation, levels can be reduced in the mea-
surement path crossover.

0.000 dB ← Ranging
Enter a negative crossover value as a measure for reducing the crossover levels. For
example, setting the level to -6 dB, the crossover is reduced by 6 dB. Drive range
increases of the same magnitude, which reduces measurement deviations due to mod-
ulation to 25% of the original value.
Note: Large signal characteristics improve as the crossover level drops. But the effects
of zero deviations and inherent noise on the result increase, caused by the less sensi-
tive measurement path being underdriven. Therefore changing the crossover level by
more than 10 dB can deteriorate the measurement result.

Manual ← Ranging
Activate manual selection of the measurement range. One out of three paths can be
selected as a measurement range, for example to the drive range of a path.

Crossover ← Ranging
Reduce crossover range.
To prevent measurement paths that have been overdriven by signal peaks from being
included in the evaluation, levels can be reduced in the measurement path crossover.
For example, if setting the level to -6 dB, the crossover is reduced by 6 dB. The drive
range increases by the same magnitude, which reduces measurement deviations due
to modulation by 25% of the original value.
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While large signal characteristics improve as the crossover level drops, the effects of
zero deviations and inherent noise on the result increase. It is caused by the less sen-
sitive measurement path being underdriven. Therefore, changing the crossover level
by more than 10 dB can deteriorate the measurement result.

path n ← Ranging
Define one of three paths as the measurement range, e.g. for testing the drive range of
a path.
Note: The Transition Offset entry disables manual functionality and vice versa.

Automatic Averaging
Use an averaging filter to reduce fluctuations in the measurement result. Either choose
automatic mode or set the averaging factor to a fixed value manually.
Note: Check if the auto filter mode is giving satisfactory results. If the power is not con-
stant, adjust a manual optimal filter length setting always manually.
"Continuous" Activate continuous mode.

This mode finds a balance between measurement time and display
noise.

"Fixed Noise" Activate fixed noise mode.
Choose an averaging factor that the sensors inherent noise (2 stan-
dard deviations) does not exceed the specified "Noise Content". Hav-
ing low power, limit the averaging factor by the duration of the "Max.
Settling Time" to avoid long settling times. In the "Info" line of the
measurement window, S/N indicates when the display noise exceeds
the preset value.
Note: Automatic averaging mode "Continuous" disables "Fixed
Noise" mode and vice versa.

Noise Content ← Automatic Averaging
Select the portion of inherent noise in the measured result. Specifically, this value gives
the permitted relative variation of the result that cannot be exceeded for 95% of the
observation time.

Max. Settl. Time ← Automatic Averaging
Enter a time value and unit to specify the upper limit for the settling time. If the limit is
exceeded, S/N is displayed in the measurement window.
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5.2.7  Signal frequency

Figure 5-11: Configure > Signal frequency dialog

Open the Section 5.2.7, "Signal frequency", on page 79 for setting the carrier frequen-
cies of applied signals. The following topics provide dialogs to specify basic signal
parameters that are independent of the sensor type. These parameters represent the
global settings and are needed in principle with the respective measuring modes.
Changes of these settings are saved in task files.

See also Section 5.4.2.3, "Diagram description bar", on page 98 to call up predefined
settings based on a measurement mode or based on a digital standard communication
signal.

Common Frequency
Apply the entered frequency value to all channels.

Channel
Select a channel.

Frequency
Enter the frequency value and unit of the signal applied to the selected channel.
Valid for all channels: disables single frequency settings and vice versa.
Note: For trace and statistics mode, the signal frequency is displayed in the Sec-
tion 5.4.2.3, "Diagram description bar", on page 98.

Configure



Settings - GUI referenceR&S®NRPV

80Manual 1173.0314.02 ─ 09

5.2.8  Continuous

Figure 5-12: Configure > Continuous

Continuous opens the dialog for configuring the measurement window settings as
aperture time, sampling frequency and smoothing.

For trace and statistics measurement mode, the signal frequency is displayed in the
Section 5.4.2.3, "Diagram description bar", on page 98.

Channel
Select a channel.

Aperture
Width of the sampling window. Defines the length of the unsynchronized time interval
used to measure the average signal power.
● For an unmodulated signal, the default setting of 10µs in conjunction with chopper

stabilization provides optimum noise suppression.
● Wider sampling windows are required when the measurement result exhibits fluctu-

ations due to modulation. With low frequency modulation in particular, a display
with optimum stability is provided by setting the sampling window length exactly
equal to the modulation period.

● If the modulation period varies or is not exactly known, we recommend that you
enable smoothing. Approximately five periods within one sampling window are suf-
ficient.

● The overall window length is calculated from the sampling frequency and the num-
ber of samples. The number of samples determines the length of the evaluation
window.

● In addition, this parameter sets the length of the unsynchronized time interval for
statistical analysis of the signal, see Section 5.2.10, "Statistics", on page 82.

Sampling Frequency
Defines the number of samples taken over the duration of a measurement window. The
sampling frequency is defined in Hertz.
● If a sensor contains a sampling A/D converter, the sampling rate can be adjusted to

prevent aliasing effects for particular types of modulation signal. Aliasing can occur
with some sensors because the sampling frequency is located within the video
bandwidth, meaning that spectral components of the modulation signal can fall in
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this frequency range. When you change the sampling frequency, the aliasing
effects disappear.

Smoothing
Enables a smoothing filter. The filter reduces result fluctuations caused by modulation,
if the aperture time cannot be exactly adjusted to the modulation period.
● Smoothing creates an approximating function to capture important trends in repeat.

Relatively slow changes of value result in a close matching of curve fitting.

5.2.9  Burst average

Figure 5-13: Configure > Burst average

The Burst average dialog contains excluding times from start/ end and dropout.

Channel
Select a channel.

Exclude from start
Defines the time gap to be excluded from measurement at the beginning of the burst.

Exclude from end
Defines the time gap to be excluded from measurement at the end of the burst.

Dropout
Define the end of the burst by setting a dropout time in microseconds. Modulation-spe-
cific power drops that are shorter than the set value are ignored.
Note: During the dropout time, unwanted trigger signals are rejected. The set dropout
time only affects the internal trigger source.
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5.2.10  Statistics

Figure 5-14: Configure > Statistics

Open the Statistics dialog, for setting the aperture time.

Channel
Select a channel.

Aperture
Width of the sampling window. Defines the length of the unsynchronized time interval
for statistical analysis of the signal.

5.2.11  Timeslots

Figure 5-15: Configure > Timeslot

Opens the dialog Timeslots for configuring timeslot and fence parameters.

Number of timeslots
Defines the number of subsequent timeslots that belong to one single frame.
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Timeslot
Contains the parameters to configure the timeslot.

Nominal width ← Timeslot
Defines the timeslot length by setting a time value and unit.
Note: For TDMA signals the nominal timeslot length must be entered here, i.e. the
frame length is divided by the number of timeslots.

Exclude from start ← Timeslot
Defines the time gap to be excluded from measurement at the beginning of the time-
slot. Enter time value and unit.

Exclude from end ← Timeslot
Sets a time value and unit for the time gap to be excluded from measurement at the
end of the timeslot.
Note: Exclude: You can also interactively set "Exclude from Start" and "Exclude from
End" interactively in the scope display in the timeslot measurement window.
Load: For various common mobile radio standards, you can load the specified parame-
ters under Section 5.2.14, "Load template", on page 87. The timeslots can be set
interactively in trace measurement mode.

Fence
Contains the parameters to configure the fence.

Active ← Fence
Activate the fence function. Fence is a time interval within the measurement period to
be excluded from measurement.

Start of fence ← Fence
Set the start of the fence referring to the timeslot and its length. Enter time value and
unit.

Length of fence ← Fence
Define a time value and unit for the length of period to be excluded from measurement.

Locked ← Fence
Block the entry fields. Defines if the timeslot parameters are editable directly or graphi-
cally. Protect the settings against accidental changes.
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5.2.12  Gates

Figure 5-16: Configure > Gates

Gates opens the dialog for configuring gate and fence parameters.

Gates
Select a gate. Up to four different gates can be configured. Measurement is performed
only in one gate at a time.

Gate
Contains the parameters to configure the gate.

Start ← Gate
Set the start time of the selected gate. Enter time value and unit.

Length ← Gate
Define the length of the gate for measurement, by setting a time value and unit.

Active ← Gate
Activate the fence function. Fence is a time interval within the measurement period to
be excluded from measurement.

Start ← Gate
Define the start of gate fence to exclude from measurement. Enter time value and unit.

Length ← Gate
Define a time value and unit for the length of period to be excluded from measurement.

Locked
Block the entry fields. Define if the gate parameters are editable directly or by graphical
means. Protect the settings against being changed by mistake.
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5.2.13  Pulse measurement

Figure 5-17: Configure > Pulse measurement

Select the algorithm for evaluating pulse signals and set the threshold parameters in
the dialog Pulse measurement.

Pulse data analysis

R&S NRPV supports pulse data analysis with R&S NRPxP, R&S NRP‑Z8x power sen-
sors that support time measurement mode.

Pulse data analysis measures all important pulse parameters according to the set
threshold levels. The following graph shows most of these parameters:

Proximal Power

Top Power

Fall TimeRise Time

Distal Power

Base Power

Pules Stop TimePule Start Time

Pulse Period

Pulse Width Pulse Off Time

Figure 5-18: Pulse data analysis diagram

The sensor calculates the pulse parameters from each measurement and delivers the
results to R&S NRPV.
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Algorithm

Select the analysis algorithm for detecting the pulse top and the pulse base power of a
pulsed signal. These two power levels are fundamental for all further signal analysis.
"Histogram" Computes the pulse levels by analyzing the histogram of the trace

data.
The histogram evaluates the probability density of the values of one
recorded trace. Thus, the histogram defines the pulse-top and pulse-
base power level because these bars contain the maximum number
of hits in the upper and lower half of the histogram. If the signal has
too much noise that there is no maximum bar, the algorithm returns
the min and max peak sample values as base level and top level.
Note: We recommend that you use this algorithm for analyzing most
of the pulse signals.

"Integration" Detects the pulse-top power by fitting a reference rectangle pulse into
the pulse signal. The algorithm calculates the integral of the pulse
power and the corresponding voltages. Thus, the algorithm approxi-
mates the signal by an ideal signal with the same energy content,
pulse duration and pulse period.
Note: We recommend that you use this algorithm for pulse signals
with fast rise- and fall times and pulses with amplitude variations, e.g.
modulated signals. E.g., use the integration algorithm if the energy
content of the complete pulse, including rising and falling edges, is
needed and not only the most probable top level.

Auto Equivalent-Time Sampling
Activates auto equivalent sampling.

Thresholds
The "High Ref Level (Distal)", "Mid Ref Level (Mesial)" and "Low Ref Level (Proximal)"
threshold parameters define the high, mid and low reference level that are used to
determine the pulse timing. All values are specified in percent of the pulse amplitude,
i.e. the difference between top and base power. Levels are related to power readings in
[Watt].

Voltage/Power related ← Thresholds
Select how the threshold parameters are calculated, either voltage related or power
related. The voltage-related parameters represent the normal case, as the usual repre-
sentation when defining the pulse parameters (rise/fall time, pulse width) is U(t). To
achieve a display with equivalent power-related values, the voltage-related threshold
values must be converted (squared).
The following table compares levels related to Volts, [Watt] and dBW.
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Table 5-2: Voltage / power-related reference level

Reference level Voltage-related(%V) Power-related (%W) Log. scale (dB)

Distal 90 81 -0.9

Mesial 50 25 -6

Proximal 10 1 -20

High Ref Level (Distal) ← Thresholds
Set the high reference level in terms of a percentage of the overall pulse level. The dis-
tal power defines the end of the rising edge and the start of the falling edge of the
pulse.

Mid Ref Level (Mesial) ← Thresholds
Set the medial reference level in terms of a percentage of the overall pulse level. This
level is used to define the pulse width (τ) and pulse period.

Low Ref Level (Proximal) ← Thresholds
Set the low reference level in terms of a percentage of the overall pulse level.
The proximal power defines the start of the rising edge and the end of the falling edge
of the pulse.

5.2.14  Load template

Figure 5-19: Configure > Load template

Open the dialog Load template for loading predefined settings of digital standard com-
munication signals such as GSM or CW.

Communication and standards

Figure 5-20: Configure > Load template > Select standard
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Currently the program provides the settings of several communication standards, plus
a CW (continuous wave) signal with set frequency and level.
"--Default–" Default values.
"<standard>" Selects the preferred from standard communication signal.
"CW" Settings from the stored CW signal.

Preserve window settings
Determine whether the window settings are to be reconfigured.
"OFF" Use the window parameters from the template to optimize the dia-

gram.
"ON" Use already determined parameters.

Preserve trigger settings
Determine whether trigger settings are to be reconfigured.
"OFF" Use the already optimized trigger parameters from the template.
"ON" Use the individually determined trigger parameters.

Activate Selected Communication Standard
Assumes the settings of the selected standard.

5.3  Trigger

Figure 5-21: Trigger menu

Trigger signals are used to configure the timing conditions for the start of a measure-
ment. The trigger system is required for the average measurement modes timeslot,
gate and burst, as well as for trace and statistics.

The "Trigger" menu contains the "Settings..." for accessing a dialog for trigger parame-
ters, covering a submenu for selecting a device intended for synchronizing trigger sig-
nals of several devices or triggering a service request.

Settings

Settings opens the trigger configuration dialog to apply a trigger source and to set the
appropriate parameters.

Trigger Sender and Sync

Trigger sender & SYNC configuration opens the dialog to set the trigger sender and
configure the synchronization.

Trigger



Settings - GUI referenceR&S®NRPV

89Manual 1173.0314.02 ─ 09

5.3.1  Settings

The trigger settings dialog contains all trigger functions.

Figure 5-22: Trigger settings dialog

Channel
Select the channel.

Trigger source
Activate the trigger source.
"Internal" Select an internal trigger source. The trigger event is generated by

the sensor.
"External" Select an external trigger source. The trigger event is executed with

the active edge of the sensor's incoming trigger signal. The active
edge is selected under "Slope".

Trigger slope
Activate the trigger slope.
"Positive" Set the rising edge of the trigger signal as an active slope. The

R&S NRPV shows the  symbol in the display.

"Negative" Set the falling edge of the signal as the active slope, indicated by .

Trigger level
Determine the high/low threshold that a trigger signal must exceed or fall short before a
trigger event is detected.

Trigger
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"Manual" Enter the power value of the high / low threshold in dBm. For a posi-
tive slope, the measurement is triggered when the signal level rises
above the threshold. The threshold determines the power level at
which the signal is high (active) or low (inactive). In case a negative
slope is set, the trigger event is initiated when the signal level falls
below the threshold.
Tip: Defining the trigger level manually.
Setting the trigger level manually is only possible for internal trigger
sources. The setting is irrelevant to all other trigger sources. To ach-
ieve stable trigger conditions, a trigger level above -20 dBm is advisa-
ble. If an S-parameter device has been activated, the trigger level set-
ting is always referenced to the input of this device. When switching
the S-parameter device on or off, the set trigger level and the entry
limits are adjusted automatically.

"Auto" Enable triggering automatically.
Note: Trigger level Auto disables editing manually and vice versa.
Tip: Automatically triggered internal source
In the trace mode, Auto activates the automatic setting of the trigger
threshold for internal triggering. The smallest and the largest sample
values within the trace length are determined. The trigger threshold is
then set exactly to the midpoint of these two values.
If no trigger events are initiated for more than 0.3 seconds, an auto-
matic search phase lasting 1 second is activated and then the trigger
threshold is reset.

Trigger delay
Enter the delay value and unit. Setting a positive value delays the effect of the trigger
event until the set time has elapsed. Entering negative values provides pretriggering,
which is, depending on the sensor type, limited to a few ms.

Dropout
Set the dropout time in seconds. Enter the value and the corresponding unit.
This parameter prevents the trigger system from being activated too early if the signal
briefly falls below or exceeds the trigger threshold. The parameter is set to a value that
is slightly higher than the maximum duration of power fluctuations that are not sup-
posed to execute triggering.

Hysteresis
Set a hysteresis value of the internal threshold. Use this function to eliminate the noise
effects on the edge detector of the trigger system.
Hysteresis is a magnitude added to the threshold. The signal level must pass the sum
of threshold and hysteresis before the next trigger event can be initiated. Trigger hyste-
resis prevents the trigger system from being activated too fast while the trigger thresh-
old is slightly fallen short or exceeded. With hysteresis, a trigger event is only initiated if
the signal level drops down the trigger level minus hysteresis for positive slopes. For
negative slopes, the level must be higher than the trigger level plus hysteresis value.
Note: Trigger hysteresis setting only applies to the internal trigger source.
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Hold off
Set a time value in seconds. Hold off suppresses trigger events within the set hold off
time, starting from the last successful triggering. Use this function to exclude unwanted
trigger events.

Locked
Block the entry fields. Determine if the trigger parameters are editable directly or pro-
tect the settings against being changed by mistake.

5.3.2  Trigger sender & SYNC configuration

Figure 5-23: Trigger Sender & SYNC dialog

The "Trigger Sender & SYNC Configuration" dialog contains the settings necessary for
configuring a trigger sender and setting the synchronization of the sensors.

Trigger sender
Selects one of the available sensors as the trigger sender.
The R&S power sensors can be operated in a trigger sender configuration. Such a
configuration enables you to select one of the available sensors to be the trigger
sender.
The sensor that is configured as the trigger sender provides a digital trigger signal in
synchronization with its own trigger event. This initiating trigger signal enables you to
synchronize several sensors (see also SYNC). You can execute measurements in sync
with a signal at low power that normally does not allow signal triggering. The trigger
signal that is output has a length of 10 µs and the positive slope coincides with the
physical trigger point. All power sensors that are connected to the trigger line and con-
figured as external trigger, start their measurements in sync with the trigger event of
the trigger sender.
NRP power sensors are equipped with two external trigger lines. Therefore you can
select the trigger sender ("External 1" or "External 2") to emit the trigger signal.
R&S NRP‑Z power sensors have only one external trigger line. Hence the trigger
sender signal can only be emitted over that connection.

SYNC
Selects whether a sensor takes part in trigger synchronization.
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To avoid spurious triggers in an interconnection of various sensors, the trigger synchro-
nization can be used. For a better understanding, note that the trigger system (by
external trigger connections) is controlled by edges, not levels. A trigger event is char-
acterized by a positive edge on the trigger line. As a consequence, a (new) trigger
event cannot be produced while the level of the trigger line keeps high, which is exactly
the purpose of the trigger sync mechanism.
When the trigger sync function is activated in a sensor, the device holds its trigger line
high while it is executing/processing the current measurement. When the sensor
becomes ready, it releases the trigger line. Since the (externally interconnected) digital
trigger line acts as a wired-or logic, the level on the trigger line stays high until the
slowest device has finished its measurement. Then the trigger line can return to low
level and another trigger event can occur by a transition to high level.

5.4  Measure

Figure 5-24: Measure menu

The "Measure" menu covers all measurement modes that are provided by R&S NRPV.
Several measurement tasks can be operated simultaneously with data acquisition and
evaluation visualized in the graphical areas of the measurement windows.

Not all measurement modes are supported by all power sensors. For details, see the
user manual of the power sensor.

A measurement starts immediately by selecting a measurement mode. Set measure-
ment parameters, mathematical operands, display settings and view the results during
measurement. Assign modifications with the "Apply" button provided in each dialog.

Select one of the listed measurement modes:

5.4.1  Measure - functions

Trace
Trace opens the trace measurement window for pulse analysis.

Measure
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Statistics
Statistics opens a measurement window for evaluating the ratio of the signal density
and distribution versus power. Determine the density and distribution with the aid of
markers.

Continuous, Gated, Timeslot or Burst Average
Select a numerical measuring mode, for example continuous, gated, burst or timeslot.
For these measuring modes, the measurement windows are almost similar, why the
description under Section 5.4.4, "Numerical", on page 135 applies to all modes. Spe-
cial features are described explicitly.
"Continuous" Select the measurement configuration dialog to set the parameters

for continuous power measurement.
"Gated" Open the configuration dialog for gated power measurement. Mea-

sure the power with a periodic envelope over defined time gates.
Specify time intervals to be excluded from measurement.

"Timeslot" Enter the configuration dialog covering parameters for timeslot mea-
surement. Use this mode to measure the power of any complex sig-
nal in defined time segments simultaneously.

"Burst Aver-
age"

Pop up a measurement window to measure the burst power of a
modulated pulsed signal.

Start/Stop
Starts or stops measurement, see Section 5.6, "Start / stop measurement",
on page 163.
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5.4.2  Trace

Figure 5-25: Measure > Trace window

In trace mode, the R&S NRPV analyzes the power envelope of the test signal and dis-
plays the power envelope as a function of time. Displaying the signal graphically as
with an oscilloscope, trace mode is particularly suitable for recognizing stable triggering
of modulated signals during the measurement.

Trace measurement is available in many R&S power sensors. For details, see the user
manual of the power sensor.

The trace dialog covers the following panels:

5.4.2.1  Trace - functions

Display panel
Indicates the measurement result in power versus time. The display is divided into the
Graph in trace mode, showing the diagram with grid, markers trigger delay and level
information, and the Diagram description bar with information on the configured traces.

Measure
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Control panel
The control panel shows all parameters that are relevant for the display. It contains but-
tons to call sub dialogs for Trace, Maths, Diagram and Marker configuration as well as
entry fields for setting power and time scaling, trigger and some miscellaneous param-
eters.

Trace...

Opens the dialog for configuring trace parameters, see Section 5.4.2.5, "Measurement
configuration", on page 100. Select trace, color, view, channel and measurand, and
apply max. hold, averaging and measurement type to the appropriate channels.

Math...

Open the dialog for configuring math parameters and operands, as described in Sec-
tion 5.4.2.6, "Math configuration", on page 102. Select channel, color, view and mathe-
matical operation and apply max hold and measurement type to the appropriate chan-
nels.

Diagram...

Open the dialog for Diagram configuration). The configuration dialog is divided in sev-
eral tabs, which are described in Section 5.4.2.9, "Diagram config. > axes",
on page 106, Section 5.4.2.10, "Diagram config. > Gates/Timeslots", on page 108,
Section 5.4.2.11, "Diagram config. > pulse", on page 109 and Section 5.4.2.12, "Dia-
gram config. > plot", on page 111.

Marker...

Marker opens the dialog for setting the position of a marker and its value in the display
and show or hide delta values.
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Power, Move/Zoom, Time, Trigger, Other

Figure 5-26: Measure > Trace > Control panel

The control panel contains the parameters to configure the trace measurement win-
dow.
For information on how to set the parameters, refer to:
● Section 5.4.2.15, "Power scale", on page 116
● Section 5.4.2.16, "Move/Zoom", on page 117
● Section 5.4.2.17, "Time scale", on page 119
● Section 5.4.2.18, "Trigger", on page 119
● Section 5.4.2.19, "Other section", on page 120
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Measurements panel

Figure 5-27: Measure > Trace > Measurements panel

Measurements panel > trace measurement includes tabs with parameters listed for
timeslot, gates and pulse measurements. View the values of the currently shown mea-
surement.

5.4.2.2  Graph in trace mode

Figure 5-28: Measure > Trace > Graph

The results window graphically represents the envelope power versus time. Shaped as
an oscilloscope display, the results window indicates:

● Diagram description bar
● Y-axis, indicating power in dB or W

Measure
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● X-axis with times scale in s
● Dotted gridlines
● A white arrow showing the reference power 
● A white arrow showing the reference time 
● Relative labels for the scale
● Trigger delay 
● Trigger level 
● Markers 
● Graph, indicating the result
● Gates and timeslot lines

For detailed information on the symbols, refer to Section 4.1.8.1, "Info and symbols",
on page 61.

5.4.2.3  Diagram description bar

Figure 5-29: Measure > Trace > graph description bar

The diagram description bar indicates various information on trace configuration. For
example, a selected channel or a math operation. The displayed symbols, values and
additional information are each identified by their assigned colors. For example, the
color of a value in a description box corresponds to the set color for measurement and
graph. The arrow at the beginning or at the end of the diagram description bar indi-
cates that not all info on the screen can be displayed. Click the respective arrow to
scroll through the description bar. For detailed information on the symbols of the
description bar refer to Section 4.1.8.1, "Info and symbols", on page 61.

5.4.2.4  Context-sensitive menu in trace mode

R&S NRPV provides a context-sensitive menu in the results window of the trace mea-
surement window. Open the context menu by pressing the right mouse button.

The context-sensitive menu of the trace measurement window covers the configuration
functions that you can also access in the control panel, the menu bar or the toolbar.

Measure
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Figure 5-30: Measure > Trace > Context-sensitive menu

The dialogs and parameters are described in this user manual. The following table lists
the context-sensitive menu items and refers to the corresponding descriptions.

Menu item Described in section ...

"Print" / "Copy To Clipboard" Section 4.1.1.3, "Print or copy to clipboard", on page 45

"Trace Configuration..." Section 5.4.2.5, "Measurement configuration", on page 100

"Math Configuration..." Section 5.4.2.6, "Math configuration", on page 102

"Diagram Configuration..." Section 5.4.2.7, "Diagram configuration", on page 104

"Marker Configuration..." Section 5.4.2.13, "Marker", on page 112

"Show Focus Values" Section 5.4.2.9, "Diagram config. > axes", on page 106

"Show Trigger Level" Section 5.4.2.18, "Trigger", on page 119

"Move/Zoom"

"Move Freely"

"Move Horizontal only"

"Move Vertical only"

"Zoom in"

"Fixed Trace"

"Zoom Out"

Section 5.4.2.16, "Move/Zoom", on page 117

"Power Auto Scale" Section 5.4.2.15, "Power scale", on page 116

"Reset Time Axis" Section 5.4.2.17, "Time scale", on page 119
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5.4.2.5  Measurement configuration

Figure 5-31: Measure > Trace > Meas configuration

The trace configuration dialog provides configuration of up to four channels for sensors
that support trace measurement. View selection boxes activate displaying the mea-
surement results of each channel separately. Also, independently of each other, the fol-
lowing parameters are provided for each channel:

● Measurand selection
● Max. hold measurement
● Averaging settings
● Selection of the measurement modes pulse, marker, gate and timeslot.

Trace 1 - 4
Indicates 4 available trace measurements.
Note: Channel Duplication. If the same trace measurement is assigned to a second
trace, an error message pops up.
It is possible to perform, e.g., an average measurement on one trace and a peak mea-
surement on a second trace within the same channel.

Channel
Select a particular channel of the signal to be measured and displayed in trace mode.
Select one of at maximum 4 channels from the list, containing only channels that pro-
vide trace measurements.
Note: The view checkbox is enabled automatically, if a channel is selected.
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Measurand
Select a channel-specific measurand. Each point represents a time interval comprising
many samples. When working with R&S NRPxP and R&S NRP‑Z8x wideband power
sensors, you can select the parameter for display.
"Average" Select the average power for the display. Average power features a

flicker-free display and a smooth trace.
"Peak" Select the highest power measured.
"Random" Select the power of a randomly selected sample. Random power pro-

vides a realistic display with signal details.

Max Hold
Set Max hold functionality. Max hold records the highest value measured for each
point, independent from Average, Random or Peak measurement. The maximum mea-
sured value is displayed.
Note: Click "Hold Reset" button in the control panel to reset the stored values, see also
Section 5.4.2.19, "Other section", on page 120. Alternatively disable the max hold
checkbox and enable it again to restart maximum value recording.

View graphically
Activate the trace for indication in the graph.

Averaging
Enable manually setting of the averaging count. The averaging count sets the number
of traces to be evaluated to form the measurement result. In manual mode the sensor
uses the averaging factor set in the averaging count entry field. In auto mode the sen-
sor determines the optimum average filter count internally based on the given resolu-
tion (0.01 dB).
Note: The following averaging count entry field is enabled only, if averaging is activa-
ted.

Avg. Count
Enter the number of values that have to be averaged to form the measurement result.
The greater this averaging factor, the less the measured values fluctuate and the lon-
ger the measurement time. The entered averaging count value is rounded off to the
nearest power of 2. Use the Up & Down arrow buttons to increment / decrement the
averaging count, also rounded to the next higher / lower power of 2 values. Increasing
averaging count reduces signal variations and noise.
The changed averaging count is transferred to the corresponding sensor, featuring the
following configurations:
● Avg. count < Min.: Averaging count is set to minimum and the decrement button is

disabled.
● Avg. count > Max.: Averaging count is set to maximum and the increment button is

disabled.
Note: If there is a min or max count set automatically, no error messages are reported.

Measurements
Select the modes to be displayed.
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Pulse ← Measurements
Enable the pulse measurement mode, described in Section 5.4.2.11, "Diagram config.
> pulse", on page 109. The corresponding pulse parameters are displayed in the trace
measurement window.

Gate Avg. ← Measurements
Enable the gate average measurement.

Gate Peak ← Measurements
Enable the gated peak measurement mode, see Section 5.4.2.10, "Diagram config. >
Gates/Timeslots", on page 108. The corresponding measurement configuration is dis-
played in the measurement window.

Gate pk/avg. ← Measurements
Enable the gated peak average measurement mode. The corresponding measurement
configuration is displayed in the measurement window. Refer to Section 5.4.2.10, "Dia-
gram config. > Gates/Timeslots", on page 108.

Timeslot Avg. ← Measurements
Enable the timeslot measurement mode, described in Section 5.4.2.10, "Diagram con-
fig. > Gates/Timeslots", on page 108. The corresponding measurement configuration is
displayed in the measurement window.

5.4.2.6  Math configuration

Figure 5-32: Measure > Trace > Math configuration

R&S NRPV can combine measured values from several sensors, using mathematical
functions. The math configuration dialog provides configuration of up to four math
channels for multichannel measurement. Each of the four channels can be assigned to
the same or to different sensors. If multiple channels use the same sensor, the mea-
surement is performed only once. The result is reused for the other channels. View
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selection boxes activate displaying the measured and computed results of each math
channels. Also, the following parameters are provided for each channel:

● Feed 1 and Feed 2 selection of the available channel traces
● Selection of math operation
● Max. Hold function
● Selection of the pulse, gate and timeslot measurement modes

Math operands can be an absolute channel or a constant that is always interpreted in
Watt.

Math 1 - 4
Indicates four math measurement channels.

Feed 1, 2
Select an available trace, a trace memory or a constant channel for the first and for the
second operand.
Note: Both operands cannot be the same channel or constant values.
"Feed 1" Select the channel to be used to calculate the displayed value.
"Feed 2" Select the second channel that is to be used for calculation.

Operation
Select a mathematical function to operate the measurement results of feed 1 and feed
2.
"SWR" Compute the standing wave ratio from the first and the second mea-

surement by using the following equation:
SWR = (1+RC) / (1-RC)
The measurement is performed in a logarithmic scale.
Note: Measure the forward power in the first channel and assign the
reflected power to the second channel.
RC is the reflection coefficient, internally calculated from the mea-
sured power values P1 in channel 1 and P2 in channel 2.
RC = 10(P1 - P2) / 20

"Diff" Subtract the measured power in the second channel from the power
of the first channel. The calculation, performed in linear scale is con-
verted to logarithmic scale. The displayed unit is dB.

"Ratio" Build the ratio of the power in the first channel to the power in the
second channel. Internally the ratio is performed by subtracting the
measured power values in a logarithmic scale. The displayed unit is
dB.

View
Select the math channels to be viewed on trace display. On selecting a math channel,
the Math trace plot is displayed in the measurement window.
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Max Hold
Set Max hold functionality. Max hold records the highest value measured for each
point, independent from the selected operation. The maximum measured value is dis-
played.
Note: Enable max hold to reset the stored values. Activating again restarts the maxi-
mum value recording.
In the measurement section of the dialog, the trace measurements are activated. Then
the measurement can be indicated in the diagram.
In the measurement section of the math configuration dialog, measurements are acti-
vated. Then the results can be indicated in the diagram.

Measurements
Assign the math function to the measurement modes.

Pulse ← Measurements
Enable the pulse measurement mode. The corresponding pulse parameters are dis-
played in the trace measurement window, as described in Section 5.4.2.11, "Diagram
config. > pulse", on page 109.

Gate ← Measurements
Enable the gate measurement mode. The corresponding parameters are displayed in
the trace measurement window, as described in Section 5.4.2.10, "Diagram config. >
Gates/Timeslots", on page 108.

Timeslot ← Measurements
Enable the timeslot measurement mode under Section 5.4.2.10, "Diagram config. >
Gates/Timeslots", on page 108. The corresponding measurement configuration is dis-
played in the measurement window.

5.4.2.7  Diagram configuration

The diagram configuration dialog provides configuration of the trace measurement
result window. All functions directly relate to the graphical data representation and do
not affect sensor settings.

The dialog covers tabs for parameter settings to:
● Select the unit for the results displayed in Section 5.4.2.8, "Diagram config. > unit",

on page 105.
● Define the scale and resolution of the axes under Section 5.4.2.9, "Diagram config.

> axes", on page 106.
● Set gates or timeslots to be viewed on the trace window in Section 5.4.2.10, "Dia-

gram config. > Gates/Timeslots", on page 108.
● Select the pulse parameters to be indicated, seeSection 5.4.2.11, "Diagram config.

> pulse", on page 109.
● Design the trace display window in Section 5.4.2.12, "Diagram config. > plot",

on page 111.
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5.4.2.8  Diagram config. > unit

Figure 5-33: Measure > Trace > Diagram configuration

The unit tab of the diagram configuration dialog contains the entry fields for assigning
unit and resolution to the y-axis. Trace data can be viewed in linear scale [Watt] or log-
arithmic scale (dBm).

Absolute/Relative
Set the unit for the y-axis the result is to be displayed. Electrical power is measured in
W and usually converted to a logarithmic scale. For a relative power level, the mea-
sured value is related to a reference power. The ratio is expressed in terms of the log
of that ratio. The unit of the power ratio is dB. An absolute power level is referred to 1
mW and expressed in dBm.
The units of the displayed parameters of the y-axis change according to the selected
unit, i.e. Min power, Max power, Rev power and power/Div are adjusted.
"dB, dBm" Assign a logarithmic scale to the y-axis to display the power ratio.
"Watt, 1" Assign a linear scale to the y-axis for displaying absolute power val-

ues.
"dBµV, dB" Assign a logarithmic scale to the y-axis to display the voltage ratio.

Resolution (Table)
Set a resolution for the unit of the y-axis. The precision of the displayed result depends
on the selected unit.
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5.4.2.9  Diagram config. > axes

Figure 5-34: Measure > Trace > Diagram > Axes

The "Axes" tab of the diagram configuration dialog provides the setting scale, resolu-
tion and position of the axes. Set the absolute values, position and grid of the refer-
ence markers, and switch on or off their display. The x-axis time scale is divided into 10
equal divisions. The same applies to the power scale of the y-axis.

Set value and scale directly in the control panel.
Change the "Reference Time" and "Time/Div" for the x-axis directly by using the entry
fields and the plus and minus buttons in the control panel of the trace measurement
dialog. In the same way, change "Reference power" and "Power/Div" for the y-axis.
See Section 5.4.2.15, "Power scale", on page 116 and Section 5.4.2.17, "Time scale",
on page 119.

X axis
Set the reference time, position and grid of the time axis. In trace measurement, the x-
axis represents the measuring time. The x-axis features delayed and physical trigger
markers, ruler and focus line. The delayed trigger marker always represents the 0 s in
the x-axis, and it is common to all the channels within the trace display. The number of
physical trigger markers is equivalent to the number of channels within the trace dis-
play. The reference time as focus is attached to the grid, graphically depicted as an
arrow. The value does not move with trace nor does it move relative to markers, and it
is independent of the number of channels. The total length of the axis is determined by
the reference time and time/div. The scale minimum depends on the trace-offset
ranges, and the scale maximum depends on the trace measurement time ranges of all
sensors that are selected for the measurement.
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Reference Time ← X axis
Specify the reference time of the trace results window. The reference time represents
the absolute center of the scale. This setting affects the graphical data representation
in the application and also the measurement and sensor configuration.

Reference Position ← X axis
Set the position of the reference time within the trace results window.

Time/Div ← X axis
Define the time value of one x-axis division. Enter value and unit. R&S NRPV uses a
fixed grid of 10 divisions for the x-axis. The time resolution is set per division with the
lowest possible value of 5 ns/div. Decimal precision more than 3 decimal places is trun-
cated in the display.
Note: Not all sensors support the same time resolution. Additional information can be
found in the sensor specifications document. R&S NRPV automatically corrects invalid
ranges for the current sensor.
Based on the X scale range, Time/Div is validated featuring the following configuration:
● Time/Div < Min.: The minimum value is set per division.
● Time/Div > Max.: The maximum value is set per division.
Note: If the start value is set automatically, no error messages are reported.

Y Axis
Set Reference power, position and grid of the level axis. The Y scale is defined by the
two parameters reference level and level step per division. The Y-axis shows the unit of
measurement selected in the unit tab. Both values can be entered manually in a loga-
rithmic or linear scale.

Reference Level ← Y Axis
Specify the upper limit of the trace results window. This setting only affects the graphi-
cal data representation in the application and has no influence on the measurement or
sensor configuration.

Reference Position ← Y Axis
Set the reference position.

Power/div ← Y Axis
Define the power value of one y-axes division. Enter value and unit. Unit depends on
the setting selected in the unit tab. Decimal precision more than 3 decimal places is
truncated in the display. Based on the Y scale range, Power/Div is validated featuring
the following configuration:
● Pow/Div < Min.: The minimum value is set per division.
● Pow/Div > Max.: The maximum value is set per division.
Note: If the start value is set automatically, no error messages are reported.

Show reference values
Show the numerical values of the reference parameters. The values are displayed right
next to the arrows of the reference markers.
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5.4.2.10  Diagram config. > Gates/Timeslots

Figure 5-35: Measure > Trace > Diagram > Gates/Timeslots

The Gates/Timeslots tab of the trace diagram configuration dialog provides selecting
gates and timeslots for measurement and view. For the display in trace mode, gates
and timeslots parameters are configured at the same time.

Gates
View and measurement checkboxes activate measuring and displaying the measure-
ment results in the trace measurement window. Provides four available trace measure-
ments.

View ← Gates
Enables the gate view of the trace measurement window. R&S NRPV displays the
active gate in the diagram as dashed lines. Gate parameters as start time, length and
fence settings are defined in Section 5.2.12, "Gates", on page 84.

Measure ← Gates
Activate the gates for measurement. R&S NRPV lists the measured values for each
selected gate in the Gates tab of the measurements panel.

Timeslots
A view checkbox activates the display of timeslots in the trace measurement window.
Select a particular timeslot for indicating the measured value.

View ← Timeslots
Enable viewing the timeslot on the trace window. R&S NRPV displays the active time-
slots in the diagram as dashed lines. The number of timeslots is defined in Sec-
tion 5.2.11, "Timeslots", on page 82.
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Measure ← Timeslots
Select a timeslot for indicating the measured value in this particular time interval.
R&S NRPV indicates the measured values of the appropriate channels in the timeslot
tab of the measurements panel.

5.4.2.11  Diagram config. > pulse

Figure 5-36: Measure > Trace > Diagram > Pulse

In the "Pulse" tab of the trace diagram configuration window, you can enable specific
pulse measurement values for display. The measurement parameters are grouped as
follows:
● "Pulse Times", covering duration, period and duty cycle.
● "Rising Edge", including rise time, pulse start time and overshoot.
● "Falling Edge", including fall time, pulse stop time and overshoot.
● "Pulse Power" with top, base, distal, mesial and proximal power parameters.
● "Signal Power", covering peak, average and minimum power.
Table 5-3: Select the checkbox to enter one of three possible states:

Show the value in the table of the measurement panel.

Graphically represent the value in the diagram and show the value in the table.

Note: A parameter, which cannot be graphically displayed, supports only check or uncheck.

Do not show the value.

Pulse Times
Contains parameters for information on the characteristic times of a pulse.
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"Pulse Duration" (Mesial power)
Displays the pulse width.
Note: Usually the interval between the 50% points of the final ampli-
tude is used to define pulse duration.

"Pulse Period" Displays the time that the pulse signal needs to complete one cycle.
"Duty Cycle" Indicates the duty cycle of the measured power. If a duty cycle of a

pulsed signal is measured, the R&S NRPV displays the average
power in the pulse.

"Equivalent Sampling Period"
Indicates the duty cycle of the equivalent sampling period.

Rising Edge
Contains falling edge signal parameter to be displayed.
"Rise Time" Indicates the time required for the signal to change from low value to

high value.
"Pulse Start Time"

Displays the start point of the current pulse, i.e. the time when the
signal crosses the medial reference level.

"Overshoot" Indicates when the final value is exceeded.

Falling Edge
Contains falling edge signal parameter to be displayed.
"Fall Time" Indicates the time required for the amplitude of a pulse signal to

change from a high value to a low value.
"Pulse Stop Time"

Displays the endpoint of the current pulse, i.e. the time when the sig-
nal crosses the medial reference level.

"Overshoot" Indicates when the final value is exceeded.

Pulse Power
Contains pulse power parameters to be displayed.
"Top Power" Indicates the power of a complete pulse, including rising and falling

edges.
Note: This function is provided by R&S NRPxP and R&S NRP‑Z8x
power sensors.

"Base Power" Indicates the base power, computed in the pulse level analysis histo-
gram of the trace data.

"Distal Power" Indicates the absolute power value of the high reference level.
"Mesial Power" Indicates the absolute power value of the mid reference level.
"Proximal Power"

Indicates the absolute power value of the high reference level.

Signal Power
Enables parameters for continuous signals for display.
"Peak Power" Indicates the measured peak power.
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"Average Power"
Indicates the measured average power.

"Minimum Power"
Indicates the minimum power value of the signal.

"Droop" Indicates the change of pulse-top power from begin to end.

5.4.2.12  Diagram config. > plot

Figure 5-37: Measure > Trace > Diagram > Plot

The "Plot" tab in the trace diagram configuration dialog covers parameters for design-
ing the trace measurement display. Set screen resolution and grid lines and assign the
label to the measurement window in this dialog.

Horiz. Resolution
Sets the number of trace points for the horizontal resolution. This setting applies to all
traces. R&S NRPV synchronizes an updated resolution with the power sensor. Based
on the minimum trace points, resolution is validated featuring the following configura-
tion:
● Horiz. Resolution < Min.: Sets minimum resolution.
● Horiz. Resolution > Max.: Sets maximum resolution.
Note: If resolution is set automatically, no error messages are reported.

Grid lines
Set grid lines to be displayed or hidden.

Name
Apply a designated name to the trace measurement window.
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5.4.2.13  Marker

Figure 5-38: Measure > Trace > Marker dialog

In trace mode, any number of markers can be defined. Markers can be assigned to
trace points for automated measurements.

You can use markers for various tasks, e.g. to define a delta to a level or a frequency
value, to refer to a reference value, or to determine the peak. The settings in the
marker dialog therefore provide countless variations.

Markers can be defined in the "Marker Configuration" dialog, which can be started by
pressing  in the configuration panel.

Initially no markers are defined. Press  to add a new marker.

(Marker) Name Assign a marker name.

View Indicate the marker in the graph.
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Line, Trace, Math Refer to a marker line, a trace-related marker or a math trace-related marker.

Ref. Marker Determine an additional reference to, e.g., an already defined marker, or a
function.

This reference is used to position the current marker.

Function Determine the task of the marker.

The possible values depend on the settings of Line, Trace and Math. A table
with available combinations can be found below.

Result refers to Determine an additional reference to, e.g., an already defined marker, or a
function. This reference is used to calculate marker results of the current
marker relative to.

By default, the marker results refer to the reference marker. It is rarely helpful
to define separate reference markers for positioning and result evaluation.

Add or remove a marker

Display the marker's names in the graph that are activated in the "View"
checkbox.

Name Assign an individual name to the marker dialog.

Save/Load Save or restore a marker configuration.

All values and parameter of the markers are shown in the marker panel underneath the
diagram. Also, you can change the function values directly in the graph by selecting
and dragging with the mouse pointer.

Marker functions in detail
Table 5-4: Marker functions

Line, Trace,
Math

Ref. Marker Function Application

Line None Fixed Time Vertical Marker Line

Fixed Power Horizontal Marker Line

<Any Marker> Rel. Time. and/or Rel.
Power depending on
reference marker type

Marker line relative to another marker value

<Any Trace> None Fixed Time Marker showing the power at a dedicated
point of time

Auto Peak Marker "riding" on the current peak of a trace

<Any Marker> Rel. Time Marker time shifted to the Ref. marker

Rel. Power <- Marker at the next position left to reference
marker where relative power is reached

Rel. Power -> Marker at the next position right to the refer-
ence marker where the relative power is
reached

Measure



Settings - GUI referenceR&S®NRPV

114Manual 1173.0314.02 ─ 09

Line, Trace,
Math

Ref. Marker Function Application

Next Peak <- Marker at the next peak left to reference
marker

Next Peak -> Marker at the next peak right to reference
marker

The math traces are handled the same way.

5.4.2.14  Example how to use markers

The example deals with two pulse traces. With the marker functionality, the R&S NRPV
measures the interval between the two pulses.

Figure 5-39: Marker example > two traces carrying pulses

To define the markers:

1. Set the first marker to indicate the peak of "Trace 1" (the blue trace)

Figure 5-40: Marker example > 1st marker

2. Set the second marker similarly for "Trace 2" (the yellow trace with the delayed
pulse):
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Figure 5-41: Marker example > 2nd marker

3. Set marker number three to detect the pulse start by searching the -3 dB point left
to the peak.

Figure 5-42: Marker example > 3rd marker

4. Set the last marker accordingly for the yellow trace.

Figure 5-43: Marker example > 4th marker

Note: The reference marker for result evaluation is not the same used for position-
ing.
In this case, we want to know the distance to the third marker "Start of Blue".
The marker results including the pulse distance are shown below the trace display:
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Figure 5-44: Marker example > traces with defined markers

The pulse distance is shown in the section of "Start of Yellow" > "Result refers to" >
"Rel. Time". The interval between the two pulses is 568.859 µs.

5.4.2.15  Power scale

Figure 5-45: Measure > Trace > Power scale

This section provides to set the reference power level and the y-axis power scale divi-
sion directly. The Y scale can be represented logarithmic or linear, defined in Sec-
tion 5.4.2.8, "Diagram config. > unit", on page 105.
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Reference Power
Adjust the reference power as the upper limit by either directly entering the value or
incrementally shift the level using the plus minus buttons. Alternatively, set the refer-
ence power level under Diagram config. > axes.
Note: This setting only affects the graphical data representation and has no influence
on the measurement.

Auto

Initiate Auto scaling for the y-axis. The lower and upper limit values are computed
according to a special algorithm. Considering all viewed traces the algorithm deter-
mines the minimum and maximum values of all the signals.
R&S NRPV updates the parameters, listed below:
● Y start, Y spread and Y stop
● Reference position marker, based on Y start change
● Trigger bar
● Y min power, Y max power and Y power/ div
● Reference position (grid value) fields in the diagram configuration
● Trace plots
Depending on the defined unit and the connected sensors, different routines are com-
puted to determine the scaling automatically.

Power / Div
Set the power range of one y-axis division. Either directly enter a value or increment /
decrement the size in fixed steps using the up and down arrow buttons. Alternatively,
set the y-axis division in Diagram config. > axes.

5.4.2.16  Move/Zoom

Figure 5-46: Measure > Trace > Move/Zoom

Covers a list for configuring the mouse movement and zoom functionality in the trace
results window.

Power/Div sets the scaling of the y-axis. Changing this value is always done by keep-
ing the reference power constant and adjusting the visible power limits accordingly.

Figure 5-47: Measure > Trace > Move/Zoom list
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Additional adjustments during zoom in
R&S NRPV does not graphically perform zoom in operation but reconfigures the sen-
sors and trace parameters to provide more detailed information on the measurement
results.

Move / Zoom
Selects the zoom functionality.
"Move Freely"

Freely changes the position of traces within the results window.
R&S NRPV adjusts affected values automatically, and even provides
moving the graphs.
How to proceed:
● Set the cursor to the position that you want to move.
● Capture a trace by pressing the left-hand mouse button.
● Keep the button pressed.
● Move the trace to the requested position.
● Release the mouse button to drop the trace at its new position.

"Move Horiz. only"
Changes the position of traces within the results window in a horizon-
tal direction. Proceed the same way as described.

"Move Vert. only"
Changes the position of traces within the results window in a vertical
direction. Proceed as described.

"Zoom In"
Freely selects any section to be zoomed in to the results window.
How to proceed:
● Set the cursor to the start point.
● Press the left-hand mouse button, and keep it pressed.
● Drag a rectangular shape around the area to be zoomed in.
● Release the mouse button to execute zooming.
Note: In this way, you can zoom in the display in several steps. Using
"Zoom out" button, you can return to the previous size. To reset the
zoom, select the "Zoom Out" button.
The R&S NRPV does not graphically perform zoom in operation but
reconfigures the sensors and trace parameters to provide more
detailed information on the measurement results.

"Fixed Trace"
Fix the trace configuration of the current measurement. Moving or
zooming the trace with the mouse is disabled.

Zoom Out

Returns the scaling to the size before zooming in. If zooming in has been performed in
several steps, zooming out operates the same way reversely.
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5.4.2.17  Time scale

Figure 5-48: Measure > Trace > Time Scale

This section provides to set the reference time and the x-axis time scale division
directly.

Modification of time scale parameters is only possible for linear scale.

Reference Time
Set the reference time by either directly entering the value or by using the up and down
arrow buttons. The two buttons increase or decrease the time in fixed steps. The
appropriate unit is added automatically to the value. Alternatively, set the reference
time under Diagram config. > axes.

Reset

Set reference time and reference position to default values.

Time/ Div
Set the time span of one X-axis division. Either directly enter the value or increment/
decrement the size in fixed steps using the up and down arrow buttons. Alternatively
set the X-axis division in Diagram config. > axes.

5.4.2.18  Trigger

Figure 5-49: Measure > Trace > Trigger

Contains a drop-down list to select the trigger mode.
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Auto Automatically starts a measurement if no trigger event has occurred after 300 ms.

Continuous Continuous triggering with regular trigger events.

Single This setting disables continuous triggering so that only one trigger event at a time is exe-
cuted. To enable triggering, press the "1Trig" key. The symbol Trigger sequence control
appears in the display.

The trigger sequence control is used to control the trigger sequence manually.

1Trig

Initiate a single trigger event manually. "1Trig" captures the signal irrespective of the
trigger level and applies the trigger event to all channels in the trace window.
Depending on the state of the Trigger mode, "1Trig" initiates different events:
● "Single deactivated": Stop a running measurement, or a restart a stopped mea-

surement.
● "Single active": First selection of Trig1 enables triggering and starts measurement.

A second stroke initiates one trigger event. The next stroke switches to manual
triggering.

Show Level
Show the trigger level line in the display.
Note: Show level only concerns indicating the trigger level line. Trigger level symbols
are permanently displayed, even if show trigger level is deactivated.

Settings

Settings opens the trigger configuration dialog to set the appropriate trigger parame-
ters.

5.4.2.19  Other section

Figure 5-50: Measure > Trace > Other

Contains a reset button for restarting the max hold function.

Hold Reset
Resets the recorded max hold values and then restart the Max Hold operation. For
information on the max hold function, see Section 5.4.2.5, "Measurement configura-
tion", on page 100.
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5.4.2.20  Measurements panel > trace measurement

Figure 5-51: Measure > Trace > Measurements

The measurements panel consists of separate tabs that contain the significant parame-
ters for timeslot, gates and pulse power measurement, and NdB down and marker
parameters. R&S NRPV displays the currently measured values.

Measurements
Contains the parameters for configuring the parameters for timeslot, gates and pulse
power measurement.

Timeslots ← Measurements
Display the currently measured power level of a selected timeslot. Select the timeslot
for indicating in Diagram config. > Gates/Timeslots.

Gates ← Measurements
Show the currently measured values of the selected gates. Display the values of av
(average power), pk (peak power) and the ratio of pk/av. Select the timeslot for indicat-
ing in Diagram config. > Gates/Timeslots.

Pulse ← Measurements
Display the currently measured values of the incoming pulse signal. Display the param-
eters selected in Diagram config. > pulse.

Marker ← Measurements
Display the settings of the markers selected for view in Marker.
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5.4.3  Statistics

Figure 5-52: Measure > Statistics window

In the statistics mode, the R&S NRPV analyzes the power envelope of the test signal
and returns an array of statistic values. The power envelope in its distribution and dis-
tribution density function is displayed. Statistically analyzing the envelope power
requires trace measurement of the signal. The measurement covers a one-time inter-
val and is repeated until the desired number of samples is attained. Multiple statistic
measurements can be performed simultaneously.

Working with R&S NRPxP and R&S NRP‑Z8x wideband power sensors, you can dis-
play the amplitude distribution as a CCDF, CDF or PDF graph.

5.4.3.1  Statistics - functions

The "Statistics" dialog covers the following functions.

Display panel
Displays the results of power measurement statistically, that means the distribution or
the distribution density. The display is divided into the Section 5.4.3.2, "Graph in statis-
tics mode", on page 124, showing the diagram with grid, markers and measurement
graph, and the Section 5.4.3.3, "Diagram description bar", on page 124 with informa-
tion on the configured measurements.
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Control panel
Shows all parameters that are relevant for the display. It contains buttons for accessing
measurement, diagram and marker configuration sub dialogs, as well as entry fields for
directly setting power and distribution scaling, distribution function and some miscella-
neous parameters.

Meas...

Opens the dialog for Measurement configuration. Select color, view and channel of up
to 4 configurable measurements. Set markers and AWGN distribution to be displayed
and select acquisition and distribution functions.

Diagram...

Opens the dialog to configure statistics display. Define the settings of the axes in Dia-
gram config. > axes and apply plot settings in Diagram config. > plot to design the dis-
play and output of the measurement results.

Marker...

Opens the dialog to set the position of the X and Y markers and their values in the dis-
play. For a detailed description, refer to Section 5.4.3.8, "Marker", on page 131.

Scale, Move/Zoom, Gate, Distribution Function and AWGN
Directly enter the values or select settings in the control panel. For description refer to
Section 5.4.3.9, "Scale", on page 132, Section 5.4.3.10, "Move/Zoom", on page 133
and Section 5.4.3.11, "Gate, distribution function and AWGN", on page 133.
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5.4.3.2  Graph in statistics mode

Figure 5-53: Measure > Statistics > Graph

The diagram area graphically represents the distribution or distribution density of the
envelope power. The results window indicates:
● Diagram description bar
● X-axis, indicating power in dB or W
● Y-axis scaled in %
● Dotted gridlines
● A white arrow showing the average power 
● Relative labels for the scale
● Markers 
● Graph, indicating the result and the additive white Gaussian noise distribution

For detailed information on the symbols, refer to Section 4.1.8.1, "Info and symbols",
on page 61.

5.4.3.3  Diagram description bar

Figure 5-54: Measure > Statistics > graph description bar
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The diagram description bar indicates various information on the statistics configura-
tion, like a selected channel or a distribution function. The displayed values and addi-
tional information are each identified by their assigned colors. The color of a value in a
description box corresponds to the color assigned to the measurement and graph. An
arrow at the beginning or at the end of the diagram description bar indicates that not all
info on the screen can be displayed. Click the respective arrow to scroll through the
description bar.

For detailed information on the symbols of the results window refer to Section 4.1.8.1,
"Info and symbols", on page 61.

5.4.3.4  Context-sensitive menu in statistics mode

R&S NRPV provides a context-sensitive menu in the results window of the statistics
measurement window. Open the context menu by pressing the right mouse button.

The context-sensitive menu of the statistics measurement window mainly covers con-
figuration functions that are alternatively accessed via the control panel, the menu bar
or the toolbar. The menu also consists of functions as, e.g., Show Hide Markers, Move/
Zoom or Auto Scale. Show/Hide Markers and Move/Zoom provide submenus for
selecting further parameters.

Figure 5-55: Measure > Statistics > Context-sensitive menu

The dialogs and parameters are described in the appropriate sections of this user man-
ual. The following table lists the context-sensitive menu items and refers to the corre-
sponding descriptions.

Menu item Described in ...

Print / Copy To Clipboard Section 4.1.1.3, "Print or copy to clipboard", on page 45

Measurement Configuration Section 5.4.3.5, "Measurement configuration", on page 126

Diagram Configuration... Section 5.4.3.6, "Diagram config. > axes", on page 129

Section 5.4.3.7, "Diagram config. > plot", on page 130

Marker Configuration

Show/Hide Markers

Move Marker to Viewing Area

Section 5.4.3.8, "Marker", on page 131

Measure



Settings - GUI referenceR&S®NRPV

126Manual 1173.0314.02 ─ 09

Menu item Described in ...

Move/Zoom

Zoom Out

Section 5.4.3.10, "Move/Zoom", on page 133

Auto Scale Section 5.4.3.9, "Scale", on page 132

5.4.3.5  Measurement configuration

Figure 5-56: Measure > Statistics > Meas configuration

In the "Configuration (Statistics Window)", you can configure up to four measurements
with sensors that support a statistics measurement. The view selection boxes activate
displaying the measurement results. You can set channel and marker separately for
each measurement, as well as general parameters for acquisition, distribution and dis-
play of the measurement results.

Measurement 1 - 4
Indicates 4 channels for statistics measurements.

Channel
Selects the channel. The list contains up to for channels, if the connected sensors sup-
port statistics measurement.
Note: The "View" checkbox is enabled automatically when you select a channel.
Note: Channel duplication. If the same statistics measurement is assigned twice, an
error message appears.
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It is possible to assign one channel to a measurement only.

View
Select the measurement result to be viewed on display.

Marker
Define a marker for either power or for density/distribution and set the positions. With
the aid of markers, you can calculate scalar values at the marker positions.

X Marker ← Marker
View the marker, positioned to a power value in the measurement window. The value
of the distribution or the distribution density is measured and displayed.

Y Marker ← Marker
Display the marker, positioned to a value of distribution or distribution density. The
power is measured and displayed.

Acquisition
Configure data acquisition parameters to be performed by the R&S power sensor.

Total Samples ← Acquisition
Enter a minimum number of samples for statistics measurement. The parameter is
used to calculate the measurement time considering the minimum and maximum val-
ues of the connected sensors.

Measurand ← Acquisition
Selects the distribution function for signal measurement and display. R&S NRPV sup-
ports the distribution functions CDF, the CCDF and PDF.

Distribution Function Measurand

Figure 5-57: Distribution Function > Function list

Updates the sensor and the measurement configuration value. The sensor can be set
to deliver CCDF statistics data directly. CCDF shows the probability that the mean sig-
nal power exceeds. The probability is represented as % in the diagram, performed
either in logarithmic or linear scale.
"CCDF (Log)" Selects the CCDF (complementary cumulative distribution function)

function with the results displayed in logarithmic scale.
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"CDF (Log)" Selects the CDF (cumulative distribution function) in a logarithmic
scale. The R&S NRPV updates the sensor using the CCDF function
and calculates the measurement results internally, by:
CDF=1-CCDF

"CCDF (Lin)" Selects the CCDF function displayed in linear scale.
"CDF (Lin)" Selects the CCDF function displayed in linear scale.
"PDF (Lin)" Selects the PDF (probability density statistics) function. The graph

represents the power histogram in linear scale.

AWGN
Adds an ideal AWGN curve as reference to the statistics data display. The reference
curve relates to the average power and can be used with all statistics modes.

Free Run / Gate
Activates measurement with an immediately executed trigger event.
Note: "Free Run" mode disables "Gate" mode and vice versa.
"Free Run" ● Active

Performs a continuous measurement during the selected time
interval, asynchronously to the waveform. If a measurement is
completed, the sensor is immediately set to the initiated status,
waiting for the next trigger event.

● Deactivated
A measurement is performed only once. Use free running for the
first measurement of signals with unknown timing and level.

"Gate 1 ...4" Select a particular gate to acquire measurement values. The mea-
surement is performed synchronously over the selected gate.
R&S NRPV provides up to four gates for measurement. Statistic gate
parameters as statistics start time, length and fence settings are
defined in Gates.
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5.4.3.6  Diagram config. > axes

Figure 5-58: Measure > Statistics > Diagram > Axes

The "Axes" tab of the diagram configuration dialog covers entry fields for defining scale
and reference position for the x-axis, and scale in dependency of the distribution func-
tion for the y-axis, respectively. In statistics measurement, the x-axis represents the
power values, and the y-axis indicates the effective frequency of the values. The
scales of both axes are divided into 10 equal divisions.

X axis
Sets a reference position and grid of the power axis and determines the start value of
the power scale.

Power/Div ← X axis
Defines the power value of one division. Enter value and unit.

Reference Position ← X axis
The scale of the x-axis is focused on the reference power that means the average
power that is applied from the sensor of the appropriate channel. Minimum and maxi-
mum values of the grid cannot be entered directly. Relating to the reference position
and power/Div R&S NRPV calculates the start and end value of the scale, with:
Start = Reference Power – (Reference position * Power/Div.)
The scale values shown in power grid lines are relative values concerning to the refer-
ence power.

Y axis
Enters the start value and grid of the probability axis referring to the distribution func-
tion. For CCDF/CDF function scale unit is % in each case, for PDF function is dimen-
sionless.
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CCDF & CDF ← Y axis
Covers the y-axis settings for the CCDF/CDF distribution function in %.

Min ← CCDF & CDF ← Y axis
Sets the start value of the probability axis for CCDF/CDF evaluation. Enter value and
unit.

Prob/Div ← CCDF & CDF ← Y axis
Defines the value of one y-axis division.

PDF ← Y axis
Covers the y-axis settings for the PDF distribution function.

Min ← PDF ← Y axis
Sets the start value of the probability axis for PDF evaluation. Enter value and unit.

Prob/Div ← PDF ← Y axis
Defines the value of one y-axis division.
Note: Modify y-axis parameters in linear scale only. Displaying the results in a logarith-
mic scale means for the CCDF or CDF function that the start and "<function>/Div" val-
ues are fixed. Modification is only possible for linear scale.

5.4.3.7  Diagram config. > plot

Figure 5-59: Measure > Statistics > Diagram > Plot

The "Plot" tab covers parameters for designing the statistics measurement display. In
this dialog, you can configure the screen resolution and grid lines, and assign a name
to the measurement window.
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Horiz. Resolution
Sets the number of pixels to specify the horizontal resolution. This setting is valid for all
statistics measurements. The R&S NRPV synchronizes an updated resolution with the
sensor.

Grid lines
Sets grid lines to be displayed or hidden.

Name
Applies a designated name to the statistics measurement window.

5.4.3.8  Marker

Figure 5-60: Measure > Statistics > Marker

In statistics mode, you can assign markers to points for automated measurements. The
marker configuration dialog covers entry fields for setting markers of the x-axis and y-
axis and determining the position of marker information in the display.

X Marker Position
Sets the X marker position in dBm.

Y Marker Position
Sets the Y marker position in %.

Right Position ← Y Marker Position
Places the probability marker on the right position, otherwise the marker is positioned
on the left-hand side.

Move to viewing area
Moves the X and Y markers in the result window when they are outside the limits of the
statistics window.

Position of values
Displays the marker values inside the grid, according to the selected location.
"Top left"

Displays the marker value list in the top-left corner of the display.
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"Top right"
Displays the marker value list in the top-right corner.

"Bottom left"
Displays the marker value list in the bottom-left corner.

"Bottom right"
Displays the marker value list in the bottom-right corner.

5.4.3.9  Scale

Figure 5-61: Measure > Statistics > Scale

In this section, you can directly set the start value and the scale division of the proba-
bility axis, and the x-axis power value of a division.

The modification of y-axis parameters is only possible in linear scale.

Y Start
Sets the start value for indicating the probability. Alternatively, you can set the start of
the y-axis under Diagram config. > axes.

CCDF/Div
Sets the value of one y-axis division. You can either directly enter a value, or decrease
or increase the size in fixed steps using the up and down arrow buttons.

Auto
Sets automatic scaling for both of the axis. The parameters defining the axes are
determined according to the following settings:
● Default starts and stops for the y-axis CCDF/CDF function, and best fit values for

the PDF function.
● Default grid and spread values for the x-axis.

Power/Div
Sets the power range of one x-axis division. Either directly enter a value or increment /
decrement the size in fixed steps using the up and down arrow buttons. Alternatively,
set the x-axis division in Diagram config. > axes.
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5.4.3.10  Move/Zoom

Figure 5-62: Measure > Statistics > Move/Zoom

Covers a list for configuring the mouse movement and zoom functionality in the statis-
tics results window.

Power/Div sets the scaling of the x-axis. Changing this value is always done by keep-
ing the average power constant and adjusting the visible power limits accordingly.

Move / Zoom
Selects the functionality for zooming in the statistics measurement window.
"Zoom In"

Freely selects any section to be zoomed in to the results window.
How to proceed:
● Set the cursor to the start point.
● Press the left-hand mouse button, and keep it pressed.
● Drag a rectangular shape around the area to be zoomed in.
● Release the mouse button to execute zooming.
Note: In this way, you can zoom in the display in several steps. Using
"Zoom out" button, you can return to the previous size. To reset the
zoom, select the "Zoom Out" button.
The R&S NRPV does not graphically perform zoom in operation but
reconfigures the sensors and trace parameters to provide more
detailed information on the measurement results.

"Fixed Trace"
Fixes the trace configuration of the current measurement. Moving or
zooming the trace with the mouse is disabled.

Zoom Out

Returns the scaling to the size before zooming in. If zooming in has been performed in
several steps, zooming out operates the same way reversely.

5.4.3.11  Gate, distribution function and AWGN

Selects the parameters for time gates and the distribution function, and activates the
AWGN graph in the display.

Alternatively, you can define the parameters in the dialog Section 5.4.3.5, "Measure-
ment configuration", on page 126.
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Gate

Figure 5-63: Measure > Statistics > Gate

Selects one of four gates. R&S NRPV transmits information to the sensor and updates
the measurement configuration. Statistic gate parameters as statistics start time, length
and fence settings are defined in Gates.
Note: Gate is available only if the free run mode is disabled.

Distribution Function

Figure 5-64: Measure > Statistics > Distribution function

Selects the distribution function. R&S NRPV updates the sensor and the measurement
configuration. Set to CDF the application transmits CCDF to the sensor and computes
the CDF results internally.

Show Ref. Curve

Figure 5-65: Measure > Statistics > Show Ref

Activates AWGN reference curve to be displayed.
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5.4.4  Numerical

Figure 5-66: Measure > Numerical window

Numerical power measurement comprises continuous, gated, timeslot and burst mea-
surements. The R&S NRPV provides for all modes separate measurement windows,
which are almost similar, except for the presentation of timeslot measurement. Every
result window has its respective tabs for relative, reset and auxiliary reset functions.

About the following description
In the following description, the information is valid for almost all numerical measure-
ment modes. If there is a special feature for a specific mode, it is pointed out.
Timeslot mode settings are described separately.

The numeric windows for continuous, gated or burst power measurement contain the
following sections:

5.4.4.1  Numerical - functions

Results windows
Results windows display the results numerically in the Results in numerical mode.
Timeslot mode features a special display, described in Graph in timeslot mode.
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Configuration controls
The control panel contains buttons for access to further measurement dialogs, math
and diagram configuration.

Meas...
Opens the dialog for configuring measurement parameters. In this dialog, you can
select the measurement, the channel and view, and determine the measurand for dis-
play. For description, refer to Section 5.4.4.6, "Measurement configuration > continu-
ous / gate / burst", on page 141.
Timeslot mode features special measurement parameters. These features are descri-
bed in Section 5.4.4.7, "Measurement configuration > timeslot", on page 143.

Math...
Math configuration opens the dialog to configure math parameters and to determine
operands for related measurements. You can define the unit, set relative measurement
and auxiliaries settings and apply styles to the results for display.

Display.../ Diagram...
Opens the dialog for configuring display settings, as described in Section 5.4.4.19,
"Display configuration", on page 153. In this dialog, you can rename the measurement
window, and define the background color and font settings. In timeslot measurement,
the dialog contains the parameters to configure the axes and plot settings accordingly.
Timeslot mode features a special display. The characterizing values are described in
Section 5.4.4.20, "Diagram config. > timeslot > axes", on page 154, and Sec-
tion 5.4.4.21, "Diagram config. > timeslot > plot", on page 155.

Gate Selection
Selects one of four gates. The R&S NRPV transmits information to the sensor and
updates the measurement configuration. Gate parameters as start time, length and
fence settings are defined in Gates.
For time gate average mode, the control panel includes an entry file for gate selection.

Note: Gate is available only if the free run mode is locked.

Snapshot ← Gate Selection
Stores the current measurement value in a *.csv file. The R&S NRPV automatically
creates a file, assigns the filename, composed of the date, time and an abbreviation for
the measurement, and stores it in the application path under
%APPDATA%\Rohde-Schwarz\NRPV\Snapshots.

%APPDATA% is a system variable, representing drive and path of the application data of
your PC.
Further snapshots of the same date and measurement are continuously stored in this
file.
Note: Move the pointer over the button to find a Tooltip with information on the direc-
tory, path and filename.
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Table 5-5: Measurement abbreviations:

CA Continuous Average

TG Time Gate

BA Burst Average

Measurements Panel
Note: Measurements panel refers to "Timeslot" measurement.
Displays power values available in a selected timeslot. For a detailed description, refer
to Section 5.4.4.22, "Measurements panel > timeslot", on page 155.

5.4.4.2  Results in numerical mode

Figure 5-67: Measure > Numerical > Results window

The results field represents a digital meter indicating the main numeric value of the
measurement and auxiliary values, selected for view under Measurement config. >
auxiliaries. An analog meter graphically represents the results. One measurement win-
dow covers a maximum of 4 result fields, including both absolute and math measure-
ments.

The main numeric result displays either the measurement value or the values resulting
from math operations. Based on unit, the result formats depend on absolute or relative
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measurement. The auxiliary result displays up to three further values of absolute chan-
nel or math measurement results. The result formats depend on the measurement
mode. Resolution is always 0.001 for auxiliary results.

According to channel, measurement and math operation, the result designation can
contain various information. For detailed information on the symbols, refer to Sec-
tion 4.1.8.1, "Info and symbols", on page 61.

5.4.4.3  Graph in timeslot mode

Figure 5-68: Measure > Numerical > Graph

The graphical timeslots average power view contains information listed below:
● Bar chart with up to 8 active slots
● Nominal width
● Trigger level
● Averaging filter count
● Reference level
● Marker measurement

All bars are continuously updated. The update rate depends mainly on the set average
filter count. The higher the filter count, the lower the update rate and the noise level. To
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the left of the timeslot results window a control panel provides entry fields for directly
setting the power levels of the scale.

If the readings in a bar exceed the upper value of the diagram, the R&S NRPV graphi-
cally indicates the overshoot by darkening the color of the respective bar.

Max power/Min power
/

Sets minimum and maximum power value for display. Both entry fields provide the unit
of measurement selected in the unit tab.
The control panel shows all parameters that are relevant for the display. It contains:
● Buttons to call sub dialogs for measurement, diagram and marker configuration
● Entry fields for directly setting power and distribution scaling, distribution function

and some miscellaneous parameters

Auto

Initiates auto scaling for the power axis. The lower and upper limit values are compu-
ted according to a special algorithm. Considering all viewed timeslots the algorithm
determines the minimum and maximum values of all the results.
R&S NRPV updates the parameters, listed below:
● Y min power, Y max power and Y power/ div
● Reference position marker, based on Y start change
● Trigger bar
● Reference position (grid value) fields in the diagram configuration
Considering the defined unit and the connected sensor, the R&S NRPV determines the
scaling automatically.

5.4.4.4  Context-sensitive menu for numerical measurement modes

R&S NRPV provides a context-sensitive menu in the result field of a numerical mea-
surement window, like continuous, gate or burst. Open the context menu by pressing
the right mouse button.

Figure 5-69: Measure > Numerical > Context-sensitive menu

The context-sensitive menu of the numerical measurement window covers configura-
tion functions, which can alternatively be accessed via the control panel, the menu bar
or the toolbar. Also, the "Save Diagram" function is included in this menu.
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The dialogs and parameters are described in the appropriate sections of this user man-
ual. The following table lists the context-sensitive menu items and refers to the associ-
ated descriptions.

Menu item Described in ...

Print / Copy To Clipboard Section 4.1.1.3, "Print or copy to clipboard", on page 45

Math Configuration... Section 5.4.4.14, "Math configuration", on page 149

Display Configuration... Section 5.4.4.19, "Display configuration", on page 153

5.4.4.5  Context-sensitive menu in timeslot mode

The R&S NRPV provides a context-sensitive menu in the result field of a timeslot mea-
surement window. Open the context menu by pressing the right mouse button.

The context-sensitive menu of the timeslot measurement window mainly covers config-
uration functions that can alternatively be accessed via the control panel, the menu bar
or the toolbar. The menu also consists of functions as for example "Show/Hide Mark-
ers" or "Save Diagram". "Show/Hide Markers" provides a submenu to set markers for
display individually.

Figure 5-70: Measure > Numerical > Context-sensitive menu Tslot

The dialogs and parameters are described in the appropriate sections of this user man-
ual. The following table lists the context-sensitive menu items and refers to the corre-
sponding descriptions.

Menu item Described in ...

Print / Copy To Clipboard Section 4.1.1.3, "Print or copy to clipboard", on page 45

Diagram Configuration... Section 5.4.4.20, "Diagram config. > timeslot > axes", on page 154

Section 5.4.4.21, "Diagram config. > timeslot > plot", on page 155

Show/Hide Markers

Marker 1

Marker 2

Marker 3

Marker 4

Right mouse click shows or hides the markers.
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5.4.4.6  Measurement configuration > continuous / gate / burst

Figure 5-71: Measure > Numerical > Meas configuration > Continuous / Burst / Gate

The "Duty Cycle" tab applies to "Continuous Av" measurement mode.

In a numerical measurement "Configuration" dialog, you can define up to four mea-
surements. You can enable the measurement results for display, select the channel
and measurand and define additional parameters, like averaging or unit covered in
separate tabs.

Measurement
Indicates the measurement number.

View
Selects the measurement to be viewed on the main numeric measurement window.
R&S NRPV views up to four measurements, including the absolute channel and maths
measurement.
Note: It is not possible to check more than 4 views.

Channel
Selects a channel for numerical measurement. The list indicates all assigned channels
supporting numerical measurement.
If the connected sensor provides time gate measurement with the specified global
parameters, the application evaluates all selected channels.
Note: Channel duplication. If the same measurement is assigned twice, an error mes-
sage appears.

Measure



Settings - GUI referenceR&S®NRPV

142Manual 1173.0314.02 ─ 09

It is possible to perform, for example, an average measurement and a peak measure-
ment within the same channel.

Measurand
Selects the measurement parameter to be displayed.
Note: In case the same measurand is assigned to a second measurement in the same
channel, an error message pops up.
"Average" Selects the average power for the display.
"Peak" Select the highest power measured.

Note: Peak is only available if the sensor supports this feature.

Tabs
Besides the settings described above, the measurement configuration dialog covers
several tabs for setting further parameters, i.e.:
● Average parameters, see Section 5.4.4.8, "Measurement config. > averaging",

on page 144.
● Units, see Section 5.4.4.9, "Measurement config. > unit", on page 145.
● Relative measurement options and reference values, see Section 5.4.4.10, "Mea-

surement config. > relative", on page 145.
● Auxiliaries, containing particular measurement values for display, see Sec-

tion 5.4.4.11, "Measurement config. > auxiliaries", on page 146.
● Duty cycle settings for calculating the pulse power of pulse modulated signals, see

Section 5.4.4.12, "Measurement config. > duty cycle", on page 147.
● Limit values, see Section 5.4.4.13, "Measurement config. > limits", on page 148.

Measure



Settings - GUI referenceR&S®NRPV

143Manual 1173.0314.02 ─ 09

5.4.4.7  Measurement configuration > timeslot

Figure 5-72: Measure > Numerical > Meas configuration > Tslot

In this dialog, you can select the channel, measurand and timeslot, and define addi-
tional parameters, like averaging, unit or reference values.

Channel
Selects a channel for measurement. The list shows all assigned channels supporting
timeslot measurement.
Note: If the connected sensor provides timeslot measurement with the specified global
parameters, the application evaluates all selected channels.

Measurand
Selects the measurement parameter to be displayed.
Note: In case the same measurand is assigned to a second measurement in the same
channel, an error message appears.
"Average" Selects the average power for the display.
"Peak" Selects the highest power measured.

Note: Peak is only available if the sensor supports this feature.

Display Timeslots
Selects the timeslots that are to be displayed in the diagram.

Tabs
Besides the settings described above, the application provides several tabs for setting
further parameters:
● Averaging parameters, see Measurement config. > averaging.
● Units, see Measurement config. > unit.
● Relative measurement options and reference values, see Measurement config. >

relative.
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5.4.4.8  Measurement config. > averaging

Figure 5-73: Measure > Numerical > Meas configuration > Averaging

In the "Averaging" tab, you can activate automatic averaging mode and set the aver-
age filter count.

The "Ref. Timeslot" entry field applies to the timeslot measurement mode.

Auto
Determines the mode for calculating the average.
"On" The sensor determines the optimum average filter count internally

based on the given resolution.
"Off" The sensor uses an averaging factor that you can set manually.

Count
Sets the number of measured values, which are averaged.
Directly entered, the value is rounded off to the closest power of two. Use the [up] and
[down] arrows to increase or decrease the averaging count. Count is rounded to the
next higher or lower power of 2x values. The greater the averaging factor, the less the
measured values vary and the measurement time is even longer.
The R&S NRPV transmits the changes to the corresponding sensor, featuring the fol-
lowing configuration:
● Avg. count < Min.: sets averaging count to a minimum and disables the decrement

button.
● Avg. count > Max.: sets averaging count to a maximum and disables the increment

button.
Note: If Min or Max count are set automatically, no error messages are reported.

Ref. Timeslot
Defines the timeslot whose power is to be used as reference for automatically calculat-
ing the average count (auto averaging).
Note: Reference timeslot selection applies to the timeslot measurement mode.
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5.4.4.9  Measurement config. > unit

Figure 5-74: Measure > Numerical > Meas configuration > Unit

The "Unit" tab of the numerical configuration dialog contains entry fields for assigning
the unit and resolution. You can view measurement and math results in linear scale
[Watt] or logarithmic scale [dBm].

Absolute
Sets the unit to display the absolute values of measurement.
"dBm" Displays the absolute value as a logarithmic power ratio.
"W" Displays the absolute power value in Watt.
"dBµV" Displays the absolute value of the logarithmic power ratio, expressed

as a voltage.

Relative
Sets the unit to display the results of relative power measurement.
"1" Displays the measured level related to a reference power.
"dB" Displays the relative value as a logarithmic power ratio.
"∆%" Displays the power ratio of result and reference power, expressed %.

Note: When using percentages, differentiate between voltage or
power quantities, and consider the x% of a quantity, or x% more or
less of a quantity.

Resolution (dB)
Selects a resolution to display the results according to that value. R&S NRPV transmits
the changed resolution value to the sensor.

5.4.4.10  Measurement config. > relative

Figure 5-75: Measure > Numerical > Meas configuration > Relative
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The "Ref. Timeslot" selection field applies to "Timeslot" measurement mode.

In the "Relative" tab, you can set parameters for relative power measurement. A rela-
tive function calculates the power or the power ratio relative to a reference value. This
mode is useful for analyzing the stability or drift during power measurement.

If you measure with the math operation "SWR" (standing wave ratio), relative measure-
ment is disabled, see Section 5.4.2.6, "Math configuration", on page 102.

Relative
Contains the parameters to configure relative power measurement.
"On" Activates relative measurement. Based on the measured values

R&S NRPV calculates the relative values according to the reference
value. Relative measurement results as ratio in linear scale.
Note: SWR measurement mode disables relative measurement.

"Off" Selects an absolute measurement or measurement of the power ratio
of two measurements.

Reset
Accepts the currently measured value as the reference value. This Reset button is
enabled when relative measurement is on.
Note: If the measurement result is invalid during the reset function, an error message
pops up.

Ref. Value
Sets a new reference value directly, or modifies a previously set value.

Ref. Timeslot
Selects a particular timeslot for indicating.
Note: Reference timeslot selection only affects the settings in timeslot mode.

5.4.4.11  Measurement config. > auxiliaries

Figure 5-76: Measure > Numerical > Meas configuration > Auxiliaries
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The "Auxiliaries" tab applies to "Continuous, Gated and Burst Average" measurement
modes. "Timeslot" mode features a special display with settings defined separately.
The characterizing values in timeslot mode are described in Section 5.4.4.3, "Graph in
timeslot mode", on page 138.

In the "Auxiliaries" tab, you can select particular measurement values for display.
Besides the main readings, you can display up to three values in the result field.

1st. / 2nd. / 3rd.
Selects up to 3 parameters for display. The R&S NRPV calculates the following values
during measurement:
"Min" The minimum value resulting from the measured samples.
"Max" The maximum value resulting from the measured samples.
"Mean" The mean value is calculated from the measured samples.
"StDev" The standard deviation calculated from the samples.
"Freq" The frequency of the measured signal.
"Count" The counted the number of samples.
"Av Count" The number of readings to be averaged for one measured value.
"None" None

Aux. Reset
Assigns the currently measured "Min", "Max", "Mean", "Num" and "StDev" values. The
"Reset" button is enabled if any of the auxiliaries entry fields is selected.

5.4.4.12  Measurement config. > duty cycle

Figure 5-77: Measure > Numerical > Meas configuration > Duty cycle

This dialog only affects continuous average power measurement of pulse-modulated
signals.

In this tab, you can activate the duty cycle correction. Using duty cycle correction, you
can determine the correction value as a percentage for pulse-modulated signals. The
sensor calculates the pulse power from the duty cycle and the average power.

Correction
Activates duty cycle correction.
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"On" Activates duty cycle correction for the corresponding sensor. If the
duty cycle is measured, the R&S NRPV displays the average power
of the pulse.
In the Info line of the measurement window, the  symbol indicates
that global offset correction has been activated.
Note: If the duty cycle correction is active, the entry field "Duty Cycle"
(%) switches to edit mode, and vice versa.

"Off" Switches off duty cycle correction.

Duty Cycle (%)
Enters the value in percent. This entry field is enabled if duty cycle correction is activa-
ted.

5.4.4.13  Measurement config. > limits

Figure 5-78: Measure > Numerical > Meas configuration > Limits

The "Auxiliaries" tab applies to "Continuous, Gated and Burst Average" measurement
modes.

In the "Limits" tab, you can set an upper and a lower limit for each measurement result.
If one of the limits is exceeded, a warning is issued.

Upper / Lower
Activates the limit check.
"On" Switches on the monitoring function for the upper limit or lower limit,

respectively.
"Off" Switches off upper/ lower limit check

Upper/ Lower Value
Specifies an upper/lower limit for the measured values. If a limit is exceeded, the warn-
ing message "Limit fail" is displayed.

Warning Beep
Activates the acoustic alarm.
"On" Activates an acoustic alarm for output if a limit is exceeded.
"Off" Turns off the acoustic alarm.
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5.4.4.14  Math configuration

Figure 5-79: Measure > Numerical > Math configuration dialog

R&S NRPV provides the "Math" functionality in the measurement modes continuous,
gate and burst.

R&S NRPV processes the results from several sensors, using mathematical functions.
The math configuration dialog provides configuration of up to four math channels for
multichannel measurement. Each of the four channels can be assigned to the same or
to different sensors. If multiple channels use the same sensor, the measurement is per-
formed only once. The result is reused for the other channels. View selection boxes
activate displaying the measured and computed results of each math channels.

In this dialog, you can select the channel and measurand, or define additional parame-
ters, as, for example, the unit, relative measurement option or auxiliaries, which are
covered in separate tabs.

Math 1 - 4
Indicates 4 available math measurements.

View
Selects the math channels to be viewed in the result field. R&S provides to display up
to four measurements, including absolute channel and math measurements.

Feed 1, 2
Selects a measurement for the first and for the second operand. The available abso-
lute channel measurements are listed for selection.
"Feed 1" Selects the channel to be used to calculate the displayed value.
"Feed 2" Selects the second channel that is to be used for calculation.
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Operation
Selects a calculation function to operate the measurement results of feed 1 and feed 2.
If the view is set, the corresponding math measurement results are displayed on the
result field.
"Ratio" Builds the ratio of the power in the first channel to the power in the

second channel. Internally the ratio is performed by subtracting the
measured power values in a logarithmic scale. The displayed unit is
dB.

"Diff" Subtracts the measured power in the second channel from the power
of the first channel. The calculation, performed in linear scale is con-
verted to logarithmic scale. The displayed unit is dB.

"SWR" Calculates the standing wave ratio from the first and the second mea-
surement by using the following equation:
SWR = (1 + RC) / (1 - RC)
The measurement is performed in a logarithmic scale.
Note: The forward power is measured in the first channel and the
reflected power is assigned to the second channel.
RC is the reflection coefficient, internally calculated from the mea-
sured power values P1 in channel 1 and P2 in channel 2.
RC = 10(P1 - P2) / 20

Tabs
Besides the settings described above, the math configuration dialog contains several
tabs, to set further parameters. The following sections describe these settings:
● Section 5.4.4.15, "Math config. > unit", on page 150
● Section 5.4.4.16, "Math config. > relative", on page 151
● Section 5.4.4.17, "Math config. > auxiliaries", on page 152
● Section 5.4.4.18, "Math config. > limits", on page 153

5.4.4.15  Math config. > unit

Figure 5-80: Measure > Numerical > Math configuration > Unit

The "Unit" tab of the math configuration dialog contains the entry fields for assigning
unit and resolution to the results. You can view math results in linear scale [Watt] or
logarithmic scale [dBm].

Absolute
Sets the unit to display the absolute values of measurement.
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Note: Units for absolute measurement. According to relative measurement, selected
with math function ratio, the unit list changes to the appropriate relative units, descri-
bed in section Relative (see below).
"dBm" Displays the absolute value as a logarithmic power ratio.
"W" Displays the absolute power value in Watt.
"dBµV" Displays the absolute value of the logarithmic power ratio, expressed

as a voltage.

Relative
Sets the unit to display the results of relative power measurement.
Note: SWR measurement mode disables relative measurement.
"1" Displays the measured level related to a reference power.
"dB" Displays the relative value as a logarithmic power ratio.
"∆%" Displays the power ratio of result and reference power, expressed %.

Note: When using percentages differentiate between voltage or
power quantities, and consider the x% of a quantity or x% more or
less of a quantity.

Resolution (dB)
Selects a resolution to display the results according to that value. R&S NRPV transmits
the changed resolution value to the sensor.

5.4.4.16  Math config. > relative

Figure 5-81: Measure > Numerical > Math configuration > Relative

The "Relative" tab provides settings for relative power measurement. Data resulting
from a math operation can be related to a reference value.

Relative
Activates the relative function.
"On" Activates relating function. Based on the calculated values,

R&S NRPV computes the relative values according to the reference
value. Relative results are output as ratio in linear scale.
Note: SWR measurement mode disables relative measurement.

"Off" Selects the absolute output of math results.

Measure
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Reset
Accepts the currently calculated value as the reference value. This "Reset" button is
enabled when the relative function is on.
Note: If the measurement result is invalid during the reset function, an error message
pops up.

Ref. Value
Enters a new reference value directly, or modifies a previously set value.

5.4.4.17  Math config. > auxiliaries

Figure 5-82: Measure > Numerical > Math configuration > Auxiliaries

In the "Auxiliaries" tab, you can determine math results for display. Along with the main
numeric value, up to three values are displayed in the result field.

1st. / 2nd. / 3rd.
Selects up to 3 parameters for display. The R&S NRPV calculates the following values:

"Min" The minimum value resulting from the calculated samples.
"Max" The maximum value resulting from the calculated samples.
"Mean" The mean value calculated from the calculated samples.
"StDev" The calculated standard deviation.
"Feed 1 / Feed 2"

The values of feed 1 or feed 2 are used for calculating.
"Count" The counted the number of samples.
"None" No value.

Aux. Reset
Assigns the currently measured Min, Max, Mean, Feed, Num and StDev values. This
Reset button is enabled if any of the auxiliaries entry fields is selected.

Measure
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5.4.4.18  Math config. > limits

Figure 5-83: Measure > Numerical > Math configuration > Limits

In the "Limits" tab, you can determine an upper and a lower limit for each calculated
result. If one of the values is exceeded, a warning is issued.

Upper / Lower
Activates the limit check.
"On" Switches on the monitoring function for the upper limit or lower limit,

respectively.
"Off" Switches off upper/ lower limit check.

Upper/ Lower Value
Specifies an upper/lower limit for the computed values. If a limit is exceeded, the warn-
ing message "Limit fail" is displayed.

Warning Beep
Activates the acoustic alarm.
"On" Activates an acoustic alarm for output if a limit is exceeded.
"Off" Turns off the acoustic alarm.

5.4.4.19  Display configuration

Figure 5-84: Measure > Numerical > Display configuration dialog

In this dialog, you can assign a name to the measurement window.

Name
Assigns a designated name to the appropriate measurement window.

Measure
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5.4.4.20  Diagram config. > timeslot > axes

Figure 5-85: Measure > Numerical > Diagram configuration > Timeslot > Axes

In the "Axes" tab, you can set the axis division, minimum and maximum power values
for the y-axis. The y-axis power scale is divided into 10 equal divisions. The y scale is
defined by two parameters, either by minimum and by maximum power or by minimum
power and power step per division. The entry fields provide the unit of measurement
selected in the unit tab. Alternatively, both values can be entered directly in the results
window of the timeslot measurement window. These settings only affect the graphical
data representation in the application and have no influence on the measurement or
sensor configuration.

Y axis
Contains the parameters for configuring the diagram axis for timeslot measurement.

Min Power ← Y axis
Sets the minimum level of the display.

Max Power ← Y axis
Enables the entry field to enter the maximum power value of the display directly. The
value defines the upper limit of the timeslot results window.

Power/Div ← Y axis
Enables the entry field to enter the power value of one division. The value, multiplied
by 10, the predefined number of divisions, defines the upper limit of the timeslot results
window.
Based on the power range of the sensor, Power/Div is validated featuring the following
configuration:
● Pow/Div < Min.: The minimum value is set per division.
● Pow/Div > Max.: The maximum value is set per division.
Note: If you have set the start value to automatic, no error messages are reported.

Measure



Settings - GUI referenceR&S®NRPV

155Manual 1173.0314.02 ─ 09

5.4.4.21  Diagram config. > timeslot > plot

Figure 5-86: Measure > Numerical > Diagram configuration > Timeslot > Plot

Activates the view of gridlines in the diagram and assign a name to the measurement
window in this dialog.

Name
Applies a designated name to the timeslot measurement window.

Grid lines
Sets grid lines to be displayed or hidden.

5.4.4.22  Measurements panel > timeslot

Figure 5-87: Measure > Timeslot

The measurements panel shows power values measured in timeslots. Activate the
timeslot for display in the measurement configuration dialog, as described under Sec-
tion 5.4.4.7, "Measurement configuration > timeslot", on page 143.

<channel>
Displays the parameters average, peak and the ratio of average to peak of the corre-
sponding channel.

M1 (#1)
Displays the values of the appropriate channel measured in the selected timeslot.

Measure
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5.5  Recording

It is often useful to record measured data, to analyze a signal in more detail after the
measurement, or to detect any irregularities that occurred over a longer period. Using
the recording function of the R&S NRPV, you can trace numerical measurement data
over a period of time. It is especially designed for long-term measurements.

A graphical representation allows you to view and check the current signal characteris-
tics quickly. You can also write the readings directly to a file. Each recorded track is
stored in a separate file in *.csv format. Since many programs can read *.csv files,
in particular spreadsheet programs, you can evaluate your measurement later.

You can select up to four parameters from a numerical measurement panel for record-
ing. During long-term recording, the function displays data in compressed form. Thus
you can monitor the measurement data continuously.

Interactions and characteristics
● Recording can only be started when the associated measurement is running.
● If recording is stopped and restarted, previous values are discarded if they have

not been saved to disk manually before restarting.
● Switching to another measurement window stops the measurement, and conse-

quently the associated recording.
● A prerequisite for the recording is that you have previously configured the mea-

surement. How to set up, for example a continuous average measurement, see
Section 3.3.3, "Measuring the average power", on page 29.

● The format of the recorded data is ASCII format, with a semicolon used as a delim-
iter.

Preparing for recording

► To open the recorder window, perform one of the following:

● In the menu bar, select "Measure > Data Recorder"

● In the toolbar, select the recorder icon .

The "Recorder" window opens.

Recording
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Figure 5-88: Recorder window

The window is tiled into four panels, according to the four tracks that can be recor-
ded per numerical measurement window.

Selecting the parameters to be recorded

You can only select a parameter for recording, if the measurement is not running.

The following example shows how to perform the recording and how to store the recor-
ded values to the hard disk.

To enable a parameter for recording, switch to the associated measurement window:

1. In the "INav" panel of the "Continuous Av" window, open the context-sensitive
menu.

Recording
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2. Select "Record" and the respective parameter in the submenu, for example "INav".

Each panel provides the appropriate parameters for the recording.
Once a parameter is checked, the R&S NRPV assigns this parameter to a panel in
the "Recorder" window.

3. Repeat these steps for the parameters that you want to record.

Recording
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You can assign up to four parameters to a recorder. The assignment of the panels
corresponds to the order of your selection.

Figure 5-89: Recorder > Selected parameters

The "Recorder" window assigns the selected parameter to the recorder panel, and
indicates the corresponding measurement panel.

Start recording

To start recording, perform the following steps:

1. In the toolbar, start the measurement .

2. If you want the R&S NRPV to write the recorded measurement results to the hard
disk simultaneously, check  in the "Recorder" window.

The R&S NRPV indicates a filename that is automatically generated for the storage
of the records.
"Record to Disk" writes the data of each active recording panel (a so-called track)
in ASCII format to the hard disk. When recording is started, the R&S NRPV auto-
matically creates one file per recorder panel in the %APPDATA% path of the com-
puter that is %APPDATA%\Rohde-Schwarz\NRPV\Recording. The automatically
assigned filenames have the structure:
REC_<year><month><day><timestamp>_Track<1...4>.csv
Tip: If you did not activate "Recording to Disk", you can still save the recorded data
manually after recording. In this case, the R&S NRPV stores the video data, which
means the compressed values, as shown in the recorder window. The longer the
recording is in progress, the higher the degree of compression.

Recording
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3. Start recording .

In the recorder window, you can see the progress of the measured parameters
over time. The R&S NRPV compresses the readings in particular time intervals by
grouping several values. It enables the application to show the measurement
results in the recorder window continuously.

Table 5-6: Displayed progress of the recording

Stop recording

You can either stop recording manually, or the R&S NRPV stops recording automati-
cally when there is insufficient storage space on the hard disk.

To stop recording manually:

► Select  in the "Recorder" window.

Recording
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Elements and controls in the recorder window

You can perform various settings in the "Recorder" window that are not apparent at first
glance. This description briefly explains the functional elements.

Figure 5-90: Recorder > controls

1 = measured parameter (measurement panel number)
2 = graph
3 = Y-axis and unit
4 = scrolling, shown when the mouse cursor is in this area
5 = time scale in seconds
6 = zooming
7 = indication of the recorder panel with keyboard focus

Table 5-7: Elements and controls in the recorder window

Legend Item Interaction via ... Description

1 Name of the
panel

— Indicates the parameter that is recor-
ded, and the measurement panel it
belongs to.

2 Graph (see zooming) Shows the progress of the measured
values graphically (over time).

3 Y-axes Mouse ( , see scrolling) Scales the axis according to the char-
acteristics of the parameter and
shows the unit of the measured val-
ues.

4 Scrolling the y-
axis

● Mouse pointer
● Cursor keys

([Up] arrow / [Down] arrow)

● Shift the graphic along the y-axis
up and down.

● When the pointer becomes a ,
use the mouse to scroll the axis.

Recording
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Legend Item Interaction via ... Description

 Scrolling the x-
axis

● Mouse pointer
● Cursor keys

([left] arrow / [right] arrow)

● Shift the graphic along the x-axis
to the left and right.

● When the pointer becomes a
, use the mouse to scroll the

axis.

5 X-axis Mouse ( , see scrolling) Indicates the recording time in sec-
onds.

6 Zoom ● Mouse pointer
● Cursor keys in combination with

the [CTRL] key:
– [CTRL]+[up] arrow
– [CTRL]+[down] arrow
– [CTRL]+[left] arrow
– [CTRL]+[right] arrow

Drag a rectangle to select the region
you want to zoom out.

– View the entire
curve

[Pos1] key Sets the panel display to its original
size.

7 Panel focused — Indicates that the panel has keyboard
focus. Navigation and zooming are
enabled.

 Panel not
focused 

— Indicates that the panel does not
have keyboard focus. Navigation and
zooming are locked.

Evaluating recorded data

If you have recorded and saved your measurement, there is at least one *.csv file.
You can open a *.csv file with a suitable program, for example with a spreadsheet
program.

Notes to the program you use for evaluation:
● The storage format of the recorded data is ASCII format, with a semicolon ";" as

the delimiter. Keep in mind that the program you are using can use a different
delimiter.

● The R&S NRPV stores the recorded values in the decimal format according to the
regional options of your computer.
If you want to evaluate the data on another computer, for example, the setting of
the numerical format can be different.

● The number of columns and rows of the spreadsheet program that you are using
could be limited. In particular, if you have executed a long-term measurement, it is
possible that the program cannot load the *.csv file completely. To fix this prob-
lem, open the source file in a text editor. Save the source file as several smaller
files that conform to this row and column limit.

If you have recorded the measurement to the hard disk by activating "Record to Disk",
the R&S NRPV stores one file per recorded track. It automatically assigns a filename
consisting of a time stamp and the recorded track.

If you have saved the file after recording using "Save Data", no filename is created
automatically, but an interactive "Save File" dialog opens and you can assign a suitable

Recording
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filename. The first line in the file provides information on the measured parameter and
a time stamp.

A file contains the measured value pairs as ASCII strings, separated by a semicolon.
Depending on the program used, the values are automatically converted and displayed
as a table when you open the file. The following description refers to MS®EXCEL. If
you use another program, the names of the mentioned commands and functions can
differ slightly.

If the data is not displayed numerically, convert the ASCII strings manually:

1. Select "Data Text to Column", or a similar command, to convert the text format to
numerical format.

2. Select ";" as delimiter and

In numerical format, you can display the results in an appropriate graph, for exam-
ple an X/Y diagram, to analyze and evaluate the measurement.

5.6  Start / stop measurement

Start
Starts the measurement in the currently active window. This button is disabled if the
measurement is running.
Note: The start command activates all the measurements, but only the measurement
in the active window is performed. The others are pending. If you switch to another
measurement window, the R&S NRPV automatically performs this one. The previously
active measurement is now pending.

Stop
Stops all active measurements.

5.7  Zero

Zeroing calibrates the external power sensor by adjusting its reading at zero signal
power. For this purpose, the RF power source must be switched off or disconnected
from the sensor (see tips below). R&S power sensors automatically detect the pres-
ence of any significant input power. It aborts zeroing and generates an error message.
Zeroing can take a few seconds, depending on the sensor model; refer to the docu-
mentation of your external power sensor for more information.

► To determine the sensor, select "Zero > Select > Channels > <channel>" in the
R&S NRPV menu bar.

Zero
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Figure 5-91: Zero menu

The selection automatically activates zeroing. The function checks the confidence
level of the sensor results.

Figure 5-92: Zeroing in progress

Zeroing can take a few seconds. During this time, the R&S NRPV displays the sta-
tus of the process in the "Zero" window. When completed, the message terminates
zeroing successfully or reports an error (succeeded / failed).

Tips for zeroing
Perform zeroing if:
● During warm-up after switching on or connecting the instrument.
● After a substantial variation of the ambient temperature.
● After fastening the power sensor module to an RF connector at high temperature.
● After several hours of operation.
● When low-power signals are to be measured, like signals with less than 10 dB

above the lower measurement limit.

Switch off the RF power source for zeroing; do not disconnect it from the sensor. This
way maintains the thermal equilibrium, and zeroing also compensates for the noise
superimposed on the measured signal (for example from a broadband amplifier).

Zero
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5.8  Window

Figure 5-93: Window menu

This menu contains functions for window handling.

Tile
Arrange all currently opened windows on the screen. The window being last active
continues to hold focus. Tiling maintains the display aspect ratio of the windows.
Note: When the measurement windows are tiled, the trace window only shows the dia-
gram area. The control panel and the measurement panel are hidden.

Cascade
Arrange all currently opened windows successively. The currently focused window
remains in the same state. Cascading maintains the display aspect ratio of the win-
dows.

Activate Next
Sets the following window active.

Activate Previous
Sets the previous window active.

Close
Quits the currently active window.

Close All
Quits all opened windows simultaneously.

5.9  Help

Figure 5-94: Help menu

The "Help" menu provides access to the help system of the R&S NRPV.

Help
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Index...
Use for help. Search for specific words or phrases, or choose from a list of keywords.
Open the HTML document in a browser, e.g. Microsoft Windows Internet Explorer.
Note: Currently, the Index function is not active. This function is intended for future
use.

About...
Retrieves information about software version and licensing of the R&S NRPV.

Figure 5-95: About R&S NRPV

Help
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6  Troubleshooting

6.1  Known restrictions

Only one instance of R&S NRPV can run at a time. When the program starts, a test
routine checks if any other instance is already running. If the program is started twice,
a warning message appears.

A simultaneous operation of R&S NRPV with other software using the R&S power sen-
sor, for example R&S Power Viewer, is also not supported.

6.2  Troubleshooting for setup problems

This section informs on possibly arising problems concerning restrictions, the operabil-
ity of power sensors and the USB interface.

6.2.1  Check if a power sensor is working properly

1. On the desktop, select "Start > Settings > Control Panel".

Figure 6-1: Settings > Control Panel

2. Select the "System Properties" dialog.

Troubleshooting for setup problems
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Figure 6-2: System Properties

3. In the "Hardware" tab, select "Device Manager."

Figure 6-3: Device Manager

If the power sensor and its drivers are installed and working properly, it is listed
under "Device Manager" > "R&S NRP-Z Power Sensors". If an unknown device is
shown instead, check the items listed in the Section 6.2.2, "USB interface prob-
lems", on page 169.

Troubleshooting for setup problems
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6.2.2  USB interface problems

Hardware

If any USB interface problems occur, consider the following measures:
● Use only high-speed hubs with power supply.
● Disconnect the power supply of the hub when switching off the computer. Connect

the hub's power supply before starting Microsoft Windows.
● Do not cascade hubs unnecessarily.
● Use only connection cables of high-speed USB 2.0 hubs.
● Exchange the hub if the measures above do not solve the problems.

Software

Supported Microsoft Windows operating systems:
● Microsoft Windows 10
● Microsoft Windows 11

Use the latest version of the R&S NRP‑Toolkit, available for download at:

www.rohde-schwarz.com/software/nrp_s_sn

6.3  Messages

Messages inform about operation states of the application, deficiencies or imperfec-
tions of functions.

Another instance is invoked........................................................................................ 169
The maximum number of viewable channels is 4....................................................... 169
Duplicate channels cannot be selected.......................................................................170
Record variable duplication. Duplicate variables cannot be recorded........................ 170
The reference value cannot be calculated.................................................................. 170
Recording is in process...............................................................................................170
The power sensor does not support the measurement mode.....................................170

Another instance is invoked.
Only one instance of R&S NRPV can run at a time. See Section 6.1, "Known restric-
tions", on page 167.

The maximum number of viewable channels is 4.
More than 4 measurements were activated. Up to four measurements, including the
absolute channel and maths measurement are possible.

Messages
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Duplicate channels cannot be selected.
A channel was assigned to a second measurement using the same measurand. For
example, if only one sensor is connected and an average measurement is running on
the first channel, you cannot measure in average measurement mode parallel on the
second channel.

Record variable duplication. Duplicate variables cannot be recorded.
The same record variable was assigned to a record trace.

The reference value cannot be calculated.
The current measurement result is invalid. Therefore the derived reference value on
pressing reset is also invalid.

Recording is in process.
The application is recording the measurement. Decide whether to proceed with the
recording or abort it.

The power sensor does not support the measurement mode.
If a power sensor does not support a measurement mode, a message is displayed.
Either use another power sensor for the measurement or select another measurement
mode.

Messages
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